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Introduction
Thank you for purchasing AutoPilot.
AutoPilot enables multi-site, PC-based facilities management for Burk Technology ARC Plus and ARC
Solo remote control systems. The customizable user interface in AutoPilot makes site management
easy for engineers, managers, and NOC operators. Built-in reports are easily tailored to individual
needs and can be printed automatically or emailed as a PDF to station personnel. AutoPilot’s 64-bit
architecture harnesses the full power of the PC for control of large and small networks.
With AutoPilot, you can:
•
•
•
•
•

Monitor and control ARC Plus and ARC Solo sites in real-time.
Automatically log site parameters using the onboard log or Microsoft SQL Server.
Automatically print or email reports to station personnel.
Build custom screens to tailor the software to your exact needs.
Manage network devices using SNMP and ping.

To configure the onboard parameters for your remote control, please use the appropriate configuration
tool:
ARC Plus
ARC Solo

AutoLoad Plus
Web Page

For more information, visit www.burk.com.

Read the Getting Started section (PAGE 1) for help setting up AutoPilot for the first time. To get the
most out of the AutoPilot software, see the In Depth section. For detailed information about specific
topics, see the Reference section (PAGE 91).

Getting Started
Overview
Working with Docking Windows
Moving Docking Windows
The position of each toolbar can be changed by clicking on the title area and dragging it. The toolbars
can be undocked into a floating window, or docked to the top, bottom, and sides of the screen.
Dropping one toolbar on top of another combines the two into the same space, allowing selection of
1

one toolbar at a time with tabs. To separate tabbed toolbars, click and hold the tab and drag away from
the toolbar.
Auto Hide
Docking windows have an auto hide feature, allowing them to disappear from view when
unneeded to maximize the available screen space for monitoring and control.
To turn auto hide on or off, click the pushpin icon in the upper right of a toolbar’s title bar. A vertical
pushpin indicates that auto hide is off and the toolbar is locked into place until you move it or turn auto
hide on. A horizontal pushpin means auto hide is on. When you remove the mouse from the toolbar
area, the toolbar will collapse into a tab on the perimeter of the screen. To display the toolbar again,
simply move your mouse over the tab.
Auto hide does not close the windows – they collapse into tabs on the sides or bottom (depending on
docked location) of the AutoPilot Plus window. To have the window reappear, simply move your mouse
over the tab. This causes the window to expand, allowing you to use it. To hide the window again, move
the mouse away from the window and it will collapse after a few seconds.
When Auto Hide is enabled, clicking the window’s title area or icon tab will lock focus on the window,
and the toolbar will not hide again until you click a different area in the program to change focus.
Reset Docking Windows
The function key F10 is mapped to the reset windows that have been docked. This option is also in the
View menu of AutoPilot.

Resources
The Resources window (known as the Navigator in versions prior to
2.10.47) is the main tool used for selecting items to work with in
AutoPilot. The Resources window shows your ARC Plus and ARC Solo
sites, Network Devices, Custom Views, and Reports.
To view an item, click on its icon. By default, Reports require a doubleclick to open. You can change this behavior in the Options dialog.
Each item in the Resources window has a context menu, accessed by a
right-click, that shows a list of actions that can be performed on that
item.
By default, the Resources window is docked to the left-hand side of the screen. You can move, hide, or
close the window to suit your needs.
New items (sites, network devices, custom views, etc.) are created in the Resources window. Once
created, these items are available to drag into the Navigator to group them into categorized views that
2

you define, as described in the next section. To completely delete an item, delete it from the Resources
window.
Navigator
The new Navigator lets you organize items from the Resources window into groups. Using a
hierarchical network view, similar to a Windows-style file system, you can create new folders and drag
in sites, custom views and reports from the Resources window wherever you like.
These groupings make it easy for you to view your site data in a way that is meaningful to you. For
example, you could group all stations managed by a certain engineer together or put all AM stations in
one group, all FM stations in a second group and all TV stations in a third group. Or you could create
regional groups for east coast, central and west coast, with subgroupings by market.
The Navigator starts out unpopulated. Create as many views within the Navigator as you like. Multiple
copies of sites, custom views and reports can be displayed in the Navigator, giving you complete
flexibility in displaying your assets. The original, underlying data remains unchanged and is displayed in
the Resources window.
To completely delete an item, delete it from the Resources window. All instances of the item are
automatically removed from the Navigator..

Unpopulated Navigator

To create a network topology within the Navigator, add new folders and drag sites, network devices,
custom views, and reports from the Resources window. You can nest folders within folders to create
hierarchies.
In this example, the main folder, FM Stations, contains a Boston Stations subfolder. The WGDH FM
station sites and Custom Views are copied into the Navigator’s Boston Stations folder.
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Copies of Items Dragged from Resources Window to Navigator

Resources Tool Tips
Tool tips are available for most Resources window and Navigator icons. Hover over an icon to see more
information about it.

Navigator Tool Tip
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Default Views
AutoPilot can display a Default View for each site without any additional configuration. To open a
default view, click on the site's icon in the Resources window or Navigator. The Default View will show
all of the channels on the selected site, using the labels and colors configured for the site.
Opening Default Views with a single click can be disabled in the Options dialog. To open a default view
when this is the case, double-click on the site or right-click and select "Default View".
Default Views may also be opened in a new window by right-clicking on the site and selecting "Default
View in New Window".
ARC Plus Channel Banks
ARC Plus sites will also show a "channel bank" selector, breaking up the site in 16 channel pages. To
view a different bank of channels, select the desired range from the drop-down list, or use the
navigation buttons.

Channel bank selector for ARC Plus sites

Default View Display Modes
AutoPilot offers three types of default views: Graphical, Grid, and Log View. To select a display mode,
use the drop-down in the Default View tool bar.

Display Mode Selector
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Graphical View
The Graphical View is the primary Default View. The Graphical View displays site data using realistic
analog gauges and LEDs.

ARC Plus Graphical View

Grid View
The Grid View displays all of the site's channels in a three-pane grid (metering, status, and commands).
Warning conditions are highlighted in yellow and critical conditions in red. This allows an operator to
quickly assess site conditions and maximizes the amount of data that can be easily read on one page.

Grid View

Logged Data View
The Logged Data View shows the site data that AutoPilot has captured and/or logged, (including
telemetry, status conditions, alarms, and events). This view allows easy access to the log without
needing to run a report. There are several options that control the behavior of the log view:
Options
Date Range
Messages

AutoPilot can show the most recent data limited by a number of days, or all of the
data in a specific date range.
The Log View always shows telemetry. Additionally, AutoPilot can include status
conditions, alarms, and events.
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Logged Data View

Custom Views Overview
Custom Views allow you to completely customize the look and feel of AutoPilot to suit your needs. For
more information about creating Custom Views, read Creating Custom Views.
Custom Views offer a wide variety of onscreen components to display site data. Custom Views can
include any number of channels of any type, from multiple sites (even using different models of remote
control).
Popular uses of Custom Views include:
•
•
•
•

Interfaces specifically designed for operators, engineers, managers, etc.
Summary screens showing high-level site data from multiple sites.
"Drill-down" interfaces allowing users to click on status indicators to learn more about alarm
conditions.
Map views to show status indicators on state, regional, or national maps, corresponding with
the location of the site.

To open a Custom View, click on the desired view in the Resources window or Navigator (Custom Views
appear in the "Custom Views" folder in the Resources window). Note that single-clicking to open a
Custom View can be disabled in the Options dialog. If this is the case, double-click on the Custom View,
or right-click and select "Show View".
To open a Custom View in a new Window, right-click on the Custom View in the Resources or Navigator
window and select "Show View in New Window".
Note: You can open a Custom View outside of AutoPilot by double-clicking the Custom View file in
Windows.
Linking Sites to Custom Views
To use a Custom View instead of the Default View for a site, right-click on the site in the Resources
window or Navigator and select "Link Custom View". AutoPilot will prompt you for the desired Custom
View file. Once you have linked a site to a Custom View, clicking on the site in the Resources window or
Navigator will open the Custom View instead of the Default View.

To restore the default behavior, right-click on the site and select "Unlink Custom View".
Note: You can still access a Default View for a site when linked to a Custom View by right-clicking on
the site and selecting "Default View".
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Reports Overview
AutoPilot Reports all you to format and print/display your logged
data from one or more sites. Reports can be viewed onscreen,
printed to paper, or saved as a PDF file. AutoPilot can automatically
print a report on a regular basis, as well as automatically email a
PDF of the report to one or more email addresses.
A Report in AutoPilot is a template, describing what data should be
included and how it should look. Whenever you run a report,
AutoPilot pulls the appropriate data from the database. Once you
have created your Report, you can run it as often as needed, and do
not need to edit it to update your data.
To learn how to create a report, read Creating Reports (SEE PAGE
36).
Running Reports
To run a report, you can print it directly, or view a print preview (either in AutoPilot's main window or in
a new window). The print preview display also allows you to save to PDF.

"Save to PDF" from the Print Preview window

Note: AutoPilot requires that you have a default printer selected in Windows to run a report - even if
you are not printing to paper. If you do not have a printer installed, you can add a printer to Windows
even if one is not connected to your computer.
To print directly, select the Report in the Resources window or Navigator and select "Print..." from the
File menu.
To run a print preview, select the Report in the Resources window or Navigator and select "Print
Preview" from the File menu. You can also simply double-click on the Report in the Resources window
or Navigator.
To open a print preview in a new window, select the Report in the Resources window or Navigator and
select "Print Preview in New Window" from the File menu.
Note: If desired, you can set AutoPilot to automatically open a print preview when you select a
Report in the Resources window or Navigator. To enable this feature, access it from the Options
dialog.
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Alarms Overview
Alarms are generated by the remote control and reported to AutoPilot either via an existing connection
or dialup call. Any time an alarm is received, AutoPilot logs the alarm to the database – even if logging
is disabled.

Terminology
Active Alarm
Inactive Alarm
Incidental Alarm
Cleared Alarm
System Alarm
Duplicate Alarm
Root Alarm
Subordinate Alarm
Alarm Severity
Alarm Priority

An alarm whose channel is presently still in an alarm state is active.
An alarm whose channel is no longer in an alarm state is inactive.
If an alarm does not have a state that will cause it to become inactive, it is an
incidental alarm.
An alarm can be cleared by a user running AutoPilot, or by another source
(such as a Web Interface user).
A system alarm is generated by the remote control to indicate an internal
error or problem.
An alarm is a duplicate if it has the same source channel as another alarm.
A root alarm is an alarm caused by a condition that may also cause one or
more other (subordinate) alarms.
A subordinate alarm is an alarm caused by a chain reaction resulting from a
different condition (a root alarm).
Alarms are either warning or critical conditions. AutoPilot displays the alarm
severity and uses it to color code alarms in Reports.
Alarm priority is a numeric value assigned to an alarm condition to help an
AutoPilot user determine which alarms are the most or least important.

The Alarm List
The Alarm List displays all alarms on all currently connected sites. By default, the Alarm List is docked
on the bottom of the screen. This is the primary means by which AutoPilot displays alarm information
and allows you to clear alarm conditions.

Alarm List
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Tool Bar Buttons
The Alarm List has its own tool bar, allowing you to clear one or more alarms and change how alarms
are displayed.
Clear All Alarms
Clear Selected Alarms
Show Cleared Alarms

Show Active Alarms Only
Show Duplicate Alarms

Clears every alarm in the Alarm List.
Clears the icon or icons that are current selected in the Alarm List.
When "Show Cleared Alarms" is enabled, the Alarm List will include
alarms that have already been cleared. Cleared alarms are show in
gray, italicized text.
When "Show Active Alarms Only" is enabled, the Alarm List will
only show "active" alarms.
When "Show Duplicate Alarms" is enabled, the Alarm List will show
every instance of an alarm. When not enabled, the Alarm List will
hide duplicate alarms, and display "More..." next to an alarm if
duplicates exist.

To clear alarms on a single site only, use the Site Alarms dialog.
Fields
Date/Time
Duration
Network
Site
Severity
Priority
Alarm Type
Message
Time Cleared

The date and time (in the local time zone) when the alarm occurred.
For inactive alarms, the duration (hours, minutes, and seconds) for which the alarm
was active.
The name of the Network in AutoPilot where this alarm occurred.
The name of the Site where this alarm occurred.
The severity (warning or critical) of the alarm.
The priority of the alarm (1 – 255).
Describes the source of the alarm (meter, status, system, user, etc).
Describes the alarm condition.
For cleared alarms, the date and time (in the local time zone) when the alarm was
cleared.

Note: To sort alarms by one of the fields above, click on the field in the list's header. Click again to
sort in the opposite direction.
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Icons
The following icons are displayed in the Alarm List to describe the type and state of an alarm:
Active Alarm
New Active Alarm
Inactive Alarm
Incidental Alarm
New Incidental Alarm

This alarm is active, not cleared, and occurred before AutoPilot
connected to the site.
This alarm is active, not cleared, and happed after AutoPilot connected
to the site.
This alarm is no longer active.
This is an incidental alarm that occurred before AutoPilot connected to
the site.
This is an incidental alarm that occurred after AutoPilot connected to
the site.

Cleared Alarm
Root and Subordinate Alarms
When Alarm Relationships are defined, the Alarm List will display an expansion icon next to a root
alarm, and "roll up" subordinate alarms.

Root Alarm, shown expanded with subordinate alarms below it

Adding Alarms
The ARC Plus supports user-generated alarms. To add an alarm to the ARC Plus, right-click the icon for
the desired site in the Resources window or Navigator and select "Add Alarm Message...". Select an
alarm severity and priority and enter a message for the alarm. Click OK to create the alarm.

Add Alarm Message Dialog

Note: Critical alarms will cause the ARC Plus to dial out, if an ESI or RSI is installed.
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Alarm Notifications
In addition to the Alarm List, AutoPilot can notify you of alarm conditions using the New Alarm dialog,
the New Alarm Desktop Alert, and sounds. For more information on configuring alarm notifications,
see Alarm Notifications (PAGE 45).

New Alarm Dialog

New Alarm Desktop Alert

Device-Specific Features

Alarm Severity
Alarm Priority
Inactive Alarms
Clear Individual Alarms
Add New Alarms

ARC ARC
Plus Solo SNMP
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
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SNMP Notes:
SNMP alarms are created when AutoPilot receives an SNMP trap from a Network Device. The message
for an SNMP alarm is determined by the OID (Object Identifier) reported by the trap.
If the OID of the trap is found in the MIB for the Network Device, the description of that OID is used for
the alarm message. If AutoPilot cannot find an entry in the MIB for the OID, it will use the OID value
itself.
Events
The ARC Plus includes an onboard Event List. The Event List displays site activity such as commands,
macro activity, connections, etc. The kinds of events stored in the log can be configured using
AutoLoad Plus.
Event List
The Event List in AutoPilot is, by default, displayed docked to the bottom of the screen in a tabbed
group with the Alarm List.

Event List

Fields
Date/Time
Network
Site
Event Type
Message

The date and time (in the local time zone) when the event occurred.
The name of the Network in AutoPilot where this event occurred.
The name of the Site where this event occurred.
Describes the source of the event (macro, command, error, etc).
Describes the event.
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Adding Events
The ARC Plus and ARC Solo support user-generated events. To add an event to the ARC Plus or ARC
Solo, right-click on the icon for the desired site in the Resources window or Navigator and select "Add
Event Message...". Enter a message for the event and click OK.

Add Event Message Dialog

Macros
ARC Plus and ARC Solo include onboard Macros. In AutoPilot, Macros can be run or stopped using the
Macro List or buttons in Custom Views.
Note: To add, edit, or remove macros from a site, use AutoLoad Plus or the Jet Designer in AutoPilot
for ARC Plus, and use the Jet Designer for ARC Solo.
Macro List
The Macro List, by default, is docked to the right side of the screen and set to auto hide.
The Macro List shows all of the macros on the selected site, and allows you to run or stop macros, and
displays the current state of each macro using the icons below. The Macro List includes Jet Flowcharts
that have been created to run directly on ARC Plus or Arc Solo.
Note: If a Custom View or Report is selected instead of a site, the Macro List will display nothing.
Tool Bar Icons
Runs the selected macro.
Run
Stops the selected macro.
Stop

Macro State Icons
Running The macro is currently running.
The macro has stopped running due to an error.
Error
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Network Devices Overview
A Network Device is any device on your LAN, WAN, or Internet that can be pinged or queried via SNMP
(Simple Network Management Protocol). AutoPilot will periodically query Network Devices, and can
use parameters from these devices in logs, reports, and Custom Views.
For more information on configuring Network Devices, see Adding Network Devices (PAGE 22).
Default View
When a Network Devices is selected in the Resources window or Navigator, AutoPilot shows a gridstyle Default View with the response time and other parameters for the selected device.
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Adding Sites
Adding ARC Plus or Arcturus Networks
Note: One or more ARC Plus or Arcturus sites configured for site-to-site communication are an ARC
Plus Network.
AutoPilot can connect to some or all of the sites in an ARC Plus Network.
To add a new ARC Plus network, click File -> New -> ARC Plus Network... to bring up the ARC Plus
Network Wizard.
Once the wizard is complete, your ARC Plus Network (and its sites) will appear in the Resources
window.
To change your settings, or add/remove sites from the network, you can return to the wizard later by
right-clicking a network in the Resources window and choosing "Edit ARC Plus Network...".
ARC Plus Network Wizard
Welcome
Click "Next" to start the Wizard.

Network Name and Login
Enter a name to describe this ARC Plus Network. The
name will be displayed through AutoPilot.
Enter your user name and password for this Network.
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Connect to your Network
Select either TCP/IP or Arcadia as your connection
method. For TCP connections, enter the IP address and
Port of any ARC Plus site on this network..
For Arcadia connection, enter the IP address of the
Arcadia Redis database. The Port number should be set
to the Redis default Port 6379. For more information,
visit www.burk.com/downloads, select the Arcadia page,
and download the Arcadia Instruction Manual.
.

Connecting
Click Next to continue after the ARC Plus Wizard
connects to your site.

Site List
Using the site tree, click the checkbox next to each site in
this network that you want AutoPilot to use. Click the
checkbox next to the "Sites" folder to select all sites.

Connections
By default, each site you have selected is configured to a
TCP/IP connection using its assigned IP address.
For any site, you can adjust the following connection
settings:
Connect automatically
When checked, AutoPilot will automatically connect to
this site on startup.
Connection method and settings
Each site's primary connection can be configured to use
TCP/IP or Arcadia
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Low speed connection
When checked, AutoPilot will adjust its timeout settings
to allow for a low speed connection (such as Satellite).
Backup Connection
When enabled, AutoPilot will switch to the backup
connection settings if the primary connection is
unavailable.
Retry primary
When a backup connection is enabled, AutoPilot can
retry the primary connection periodically.

Logging
If desired, AutoPilot can automatically log all or some of
the sites on this network.
Logging can be configured individually for each site, or all
sites in this network can use the same settings. Using
either method you can configure the following:
Enable logging on this site
Checking this box enables logging for the selected site(s).
Configure all sites or individual sites
Select Configure each site individually if you want to
customize settings for each site. Select Use the same
settings for all sites in the network to apply the settings to
all sites.
Interval
This is the frequency, in minutes or hours, at which
AutoPilot will take its log.
Next log
This is the time of day when AutoPilot will take its first
log. AutoPilot will always add the logging interval to the
next log time to determine when it is time to log again.
By doing so, AutoPilot can keep to a regular "pattern" for
its log (such as every hour on the hour).
Download Captures from this site
Select the Download Captures from this site option to
enable the Captures feature, available on ARC Plus Touch
units with firmware 5.0.8.1 or newer, allows you to
configure the ARC Plus Touch to store periodic captures
18

(snapshots) of a specified range of channel values locally
on The ARC Plus Touch. You can create a download
schedule on any AutoPilot system to automatically
retrieve the captures. If this setting is disabled and reenabled it will force AutoPilot to download all captures
available on the ARC Plus at the next specified download
time.
Interval
The download Interval (the frequency, in minutes or
hours), at which AutoPilot will download its next captures
from the ARC Plus.

Finish
Click Finish to save your ARC Plus Network and close the
wizard.
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Adding ARC Solo Networks
To add a new ARC Solo network, click File -> New -> ARC Solo Network... to bring up the ARC Solo
Network Wizard.
Once the wizard is complete, your ARC Solo Network (and its sites) will appear in the Resources
window.
To change your settings, or add/remove sites from the network, you can return to the wizard later by
right-clicking a network in the Resources window and choosing "Edit ARC Solo Network...".
ARC Solo Network Wizard
Welcome
Click "Next" to start the Wizard.

Network Name and Login
Enter a name to describe this ARC Solo Network. The name will
be displayed through AutoPilot.
Enter your user name and password for this Network.
Enable Always prompt for password when connecting if you
want to disable an automatic connection to log.

Connection
Enter the hostname or IP address of the host.
Select the host port.
Connect automatically
When checked, AutoPilot will automatically connect to this site
on startup.
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Logging
If desired, AutoPilot can automatically log all or some of the sites
on this network.
Logging can be configured individually for each site, or all sites in
this network can use the same settings. Using either method you
can configure the following:
Enable logging
Checking this box enables logging for the selected site(s).
Log every
This is the frequency, in minutes or hours, at which AutoPilot will
take its log.
Next log
This is the time of day when AutoPilot will take its first log.
AutoPilot will always add the logging interval to the next log
time to determine when it is time to log again. By doing so,
AutoPilot can keep to a regular "pattern" for its log (such as
every hour on the hour).
Finish
Click Finish to save your ARC Solo Network and close the wizard.
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Adding Network Devices
To add a new Network Device, click File -> New -> Network Device... to bring up the Network Device
Wizard.
Once the wizard is complete, your device will appear in the Resources window and you can drag it into
Navigator.
To change your settings, you can return to the wizard later by right-clicking a device in the Resources
window or Navigator and choosing "Edit Network Device".
Network Device Wizard
Welcome
Click "Next" to start the Wizard.

Device Settings
Enter a name to describe this device. The name will be
displayed through AutoPilot.
Enter the IP address for this device.
If desired, adjust the timeout (the number of seconds AutoPilot
will wait for a response to a ping or SNMP GET request).
Ping and SNMP
You can enable ping and/or SNMP management for this device.
When using ping, enter the rate (in minutes) at which you want
to ping this device.
For SNMP management, the following parameters are
available:
SNMP port
The port used by this device's SNMP agent (161 by default)
Community string
The read only community string for the SNMP agent.
SNMP version
The version of SNMP used by the SNMP agent (1, 2c, or 3).
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User name
(For SNMP v3 only) your user name on the SNMP agent.
Password
(For SNMP v3 only) your password on the SNMP agent.
MIB Files
By default, AutoPilot includes the standard MIB files. You can
add additional MIB files for device or vendor specific
parameters by clicking the "Add" button.
AutoPilot uses the MIB to facilitate selecting parameters (see
below), and for reading SNMP traps.

MIB Browser
Use the MIB browser to select the parameters you want
AutoPilot to use. When you select a parameter in the tree,
AutoPilot will display its name, OID (Object Identifier) and
description. Click "Get" to read this value.

Other OIDs
To add OIDs that are not available in your device's MIB, enter
the OID value and assign it a name.
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SNMP Channel Assignment
For each parameter you have chosen, you can assign the
following:
Channel type

Parameters can be interpreted as meters, status, or text
channels.
Polling rate

This is the rate at which AutoPilot will request the value for this
parameter.
Each type of channel has different configuration options. You
can configure how the channel behaves and how it is displayed
in AutoPilot.
Meter
Settings
Label

Assign a label to describe this meter.
Units

The units label for this meter.
Decimal places

The number of decimal places to show for this meter's value.
Meter min

The minimum value shown on a graphical meter for this
channel.
Meter max

The maximum value show on a graphical meter for this channel.
Multiplier

AutoPilot will multiply the value received from the SNMP agent
by the multiplier.
Limits
2nd Low [color]

The color displayed for the second lower limit of a graphical
meter.
2nd Low [value]

The value where the second lower limit of the meter begins.
1st Low [color]

The color displayed for the first lower limit of a graphical meter.
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1st Low [value]

The value where the second first limit of the meter begins.
Normal

The color displayed for the "normal" range of a graphical meter.
1st High [color]

The color displayed for the first upper limit of a graphical meter.
1st High [value]

The value where the second first upper of the meter begins.
2nd High [color]

The color displayed for the second upper limit of a graphical
meter.
2nd High [value]

The value where the second upper of the meter begins.
Status
On Label

The label that will be displayed when the status is "on".
Off Label

The label that will be displayed when the status is "off".
On Color

The color that will be displayed for a status indicator when the
status is "on".
Off Color

The color that will be displayed for a status indicator when the
status is "off".
On string

AutoPilot will consider this status channel to be "on" when the
value received from the SNMP agent matches the "on string".
Text
Label

The label describing this channel.
If this channel is used to measure a duration (such as "uptime"),
check the corresponding checkbox. AutoPilot will read the
value of this parameter as a duration and display it
appropriately.
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Logging
If desired, AutoPilot can automatically log this device. The
following logging parameters can be configured:
Enable logging
Checking this box enables logging for the device.
Interval
This is the frequency, in minutes or hours, at which AutoPilot
will take its log.
Next log
This is the time of day when AutoPilot will take its first log.
AutoPilot will always add the logging interval to the next log
time to determine when it is time to log again. By doing so,
AutoPilot can keep to a regular "pattern" for its log (such as
every hour on the hour).
Time zone
Select the time zone where this device is located.
Note: AutoPilot only logs meter and status channel on Network
Devices. "Text" channels are not included in the log.

Finish
Click Finish to save your device and close the wizard.

Alarms on Network Devices
AutoPilot will automatically treat incoming SNMP traps as alarms for the Network Devices you have
added. Be sure to include the appropriate MIB files to be sure AutoPilot is able to correctly identify
alarms.
Note: To configure your SNMP agent to send traps to AutoPilot, refer to the documentation for the
device, or contact your network administrator.
AutoPilot uses UDP port 162 to receive SNMP traps.
Only one program on your computer can operate as an SNMP manager using the standard port
numbers. If you have another SNMP manager running already, you must first disable it before you can
use SNMP management in AutoPilot.
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Only one program on your computer can operate as an SNMP manager
using the standard port numbers. If you have another SNMP manager
running already, you must first disable it before you can use SNMP
management in AutoPilot.

Creating Custom Views
Custom Views allow you to tailor AutoPilot's interface to suit your operation's needs. You can create
Custom Views using built-in templates, or from scratch with the Custom View Editor.
Terminology
Custom View Control
Binding

Control Properties
Custom View
Template
Selection Handles

A Custom View Control is an onscreen element such as a graphical meter,
status LED, or command button.
Binding a Custom View Control to a remote control channel or other
parameter creates a link between that parameter's value or associated
action and the behavior of the control. Binding to a meter channel causes
the control to display the meter's value. Binding to a status condition
causes the control to display the status condition (on or off). Binding to a
command causes the control to execute that command when clicked.
A control's properties are attributes that define its appearance and
behavior, such as colors, limits, and labels.
A Custom View Template is a pre-defined Custom View that you can
associate with your site. You can edit the resulting Custom View to tailor it
to your specific needs.
Selection handles are squares that appear around a selected control.
Selection handles are used to indicate which control or controls are
selected, and to resize the control.

Custom View Editor Overview
The Custom View Editor allows you to create and edit Custom Views. The components of the editor are
described below.
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Canvas
The canvas is where you will arrange your Custom View controls. When you display your Custom View
in AutoPilot, only the canvas is shown.

Canvas

Grid
By default, the Custom View Editor displays grid dots on the canvas. The grid is useful for aligning and
positioning controls.
You can turn the grid on an off by clicking "Show Grid" from the View menu in the Custom View Editor.
Primary Control Selection
When more than one control is selected, one control is the primary control. Some actions in the Custom
View Editor only apply to the primary selection, or otherwise relate to it.
The primary control is indicated by normal selection handles (black, by default). Secondary selection
handles are shown using a reverse color scheme.

Multiple controls selected. The primary control is shown with black selection handles.

Note: When displayed in AutoPilot, your Custom View will not show the grid.
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Toolbox
The toolbox is a categorized list of all the Custom View controls available to you. Each control appears
in its associated category (Meters, Status, etc), as well as in the "All Items" category. To add a control to
the canvas, click and drag the control to the desired location. When you release the mouse button, the
Custom View Editor will add a new instance of the selected control to the canvas.

Toolbox

Properties
The properties grid displays and allows you to edit all of the properties for the selected control.
To change a property, select its value in the grid and replace it with the desired value. Some properties
use pull down menu or popup dialog (indicated by a "..." button).
A description of each property appears at the bottom of the property grid when a property row is
selected.
Note: If more than one control is selected, the properties grid uses the primary control (see above).

Properties
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Undo History
The undo history list displays recently performed actions that you can undo (or redo). Double-clicking
on an item in the list will undo or redo that action.

Undo History

Adding, Positioning and Sizing Controls
To add a control to the Custom View canvas, click and drag the control from the toolbox and drop it
onto the canvas.
To move a control already on the canvas, simply click and drag to reposition it.
To resize a control, select the control by clicking on it and use the grab handles to resize it. Control scan
be resized horizontally or vertically, or diagonally using the corner handles.
Snap to Grid
To make it easier to align and position controls, the Custom View Editor can force controls to conform
to the grid as they are moved and sized. This functionality is enabled by default, and can be toggled by
selecting "Snap to Grid" from the Format menu.
Positioning Controls on Top or Below Other Controls
Use "Send to Back" and "Bring to Front" from the Format menu to position controls above or below
other controls on the canvas.
Sizing and Aligning Controls Relative to Other Controls
The Custom View Editor has several tools that allow you to size and align controls relative to other
controls on the canvas. These are useful tools to help create Custom Views with a polished, professional
appearance.
To use these tools, select multiple components at once by using Ctrl+Click or clicking and dragging a
selection rectangle around the desired controls.
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Align Lefts
Align Centers
Align Rights
Align Tops
Align Middles
Align Bottoms
Make Same Width
Make Same Height
Make Same Size
Make Horizontal Space Equal
Increase Horizontal Space
Decrease Horizontal Space
Remove Horizontal Space
Make Vertical Space Equal
Increase Vertical Space
Decrease Vertical Space
Remove Vertical Space
Center Horizontally in View
Center Vertically in View

Aligns all the controls on the left-hand side.
Aligns all the controls in the center.
Aligns all the controls on the right-hand side.
Aligns all the controls on the top.
Aligns all the controls in the middle.
Aligns all the controls on the bottom.
Sets all the controls to the same width.
Sets all the controls to the same height.
Sets all the controls to the same size.
Spaces all the controls so that horizontal spacing is equal
between each control.
Increases the horizontal spacing between each control.
Decreases the horizontal spacing between each control.
Removes all horizontal spacing between the controls.
Spaces all the controls so that vertical spacing is equal between
each control.
Increases the vertical spacing between each control.
Decreases the vertical spacing between each control.
Removes all vertical spacing between the controls.
Positions the controls in the center of the view horizontally.
Positions the controls in the center of the view vertically.

Binding to Channels
Binding a control to a channel connects its value or action to the selected channel. Controls can be
bound to the following:
•
•
•
•
•

Commands (relays on a remote control or actions performed in AutoPilot).
Meters
Status (remote control status channels or other site conditions).
SNMP strings
Network Device state
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To bind a control, right click on the control and select the type of channel to which you want to bind.

Context menu used to bind channels. Normally, unavailable channel types are grayed out.

Binding Dialogs
To finish binding a channel, use the binding dialog to select the channel (or other data) to which you
want to bind.
Check "Automatically set related properties" if you want the properties for this control to match the
settings for the target channel as configured in AutoLoad Plus. For example, if you are binding a
graphical meter to a meter channel, checking this box will set the min and max values and colors to
match the configuration of the meter channel.

An example of a binding dialog. The dialog varies based on the type of channel and other selections.
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Customizing Control Properties
Every Custom View control has its own set of properties that you
can use to customize its appearance and behavior. These
properties are displayed in the properties window, docked, by
default, to the right side of the screen.
To adjust a property, simply select it in the grid and enter the
desired value.
Some properties use a drop-down display or popup dialog to
support more advanced editing. Some properties have
expand/collapse buttons to show more/less to expose/hide
additional settings related to a property (such as "Size" and
"Location").
A brief description of each property is available at the bottom of
the property grid.
Note: For objects that have a customizable image property, the
image size must be smaller than 3MB.
Map to Key Property
The Click Action group for each Custom View control includes a
property called “Map to Key”. This property makes it possible to
activate the control’s click action by pressing the configured
keyboard key.
Adjusting the Property Grid Display
• The pane at the bottom of the property grid used for the description can be resized to show
more or less of the text.
• The columns of the property grid can be resized by clicking on the vertical dividing line between
them.
• The properties listed in the grid can be sorted alphabetically or organized by group. Use the
buttons in the property grid tool bar to change the order.
Using Charts
The Custom View Chart control allows you to plot one or more meter channels on a strip chart. Because
the chart control can support multiple lines, using it is different from other metering controls.
Creating a New Chart
Begin by dragging and dropping a chart onto the Custom View canvas, as you would any other control.
To add a meter channel to the chart, use the "Chart Lines" property, found in the "Data" category in the
property grid. Click the [...] button to open the editor dialog.
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Select the network, site, and channel for the line you want to add. Click "Save" to add the line to the
chart. You may add as many lines as you like, and can specify the color and style (solid, dotted, etc) for
each line.

The Chart Lines dialog

The following fields are available for each chart line:
Channel Type
Network
Site
Channel
Label
Color
Line Style
Area Style
Y Axis

The type of channel to be plotted.
The network containing this meter channel.
The site containing this meter channel.
The meter channel you want to plot.
The label to use for line name.
The color the chart will use to draw this line.
The style of the line (solid, dotted, etc).
The area fill style to use (solid or none).
The axis (left or right) that this line will use as its Y-axis.

Using the Secondary Y-Axis
If you want to use a single chart to plot channels that use two different units – such as forward power as
a percentage and reflected power in Watts – you can use both the left and right Y-axes. To do so, simply
pick "Left" or "Right" as desired for each line in the Chart Lines dialog.
Adjusting the Y-Axis Range
By default, AutoPilot will automatically scale the y-axis range to suit the data plotted on the chart. This
range will continue to change over time as new values arrive. If you would prefer to configure a static
range, you may do so using the "Left Y Axis" and "Right Y Axis" properties for the chart.
First, set the "Auto Scale" property of the axis to "False". Then set the "Minimum Value" and "Maximum
Value" properties to suit your needs.
Adjusting the Time Span
The duration of the chart is configured using the "Duration (sec)" property of the chart. This specifies
the time span represented by the x-axis. Although this property uses seconds, the chart supports
months or even years of data.
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Pre-Loading Data and Background Caching
When AutoPilot first loads a chart, it will use your logged data to pre-load values into the chart. The
amount of data available for this feature depends on your logging settings and the range of the chart.
When AutoPilot starts, it will immediately begin "caching" data for your charts, even if they are not on
screen.
Editing and Deleting Custom Views
Editing Existing Custom Views
To edit an existing Custom View, right-click on the Custom View in the AutoPilot Resources window or
Navigator and select "Edit Custom View...". AutoPilot will open the Custom View in the Custom View
Editor.
You can also use the File -> Open dialog in the Custom View Editor to open a Custom View file directly.
Deleting Custom Views
To delete a Custom View, right-click on the Custom View in the AutoPilot Resources window and select
"Delete". If you delete a Custom View from the Navigator, only that instance of the view is deleted. To
completely remove the Custom View, it must be deleted in the Resources window.
Note: If you delete a Custom View file directly in Windows, AutoPilot will automatically remove that
Custom View from the Resources window and Navigator.
Using Custom View Templates
Custom View Templates allow you to quickly configure a pre-defined Custom View to work with one of
your sites. A template that resembles the Default View is available, as well as templates for
PlusConnect™ transmitter interfaces.
To create a new Custom View from a template, open the Custom View Editor (File  New Custom
View) and select "New From Template" from the File menu in the editor.
The "Load Template" dialog will prompt you for the following information:
Template
Network
Site
Starting channel

Click the browse button ("...") to locate the template you want to use.
Choose the network containing the site that you want to use for this Custom
View.
Choose the site that you want to use in this Custom View.
Templates are designed to work with a sequential set of channels. For example,
to use channels 17-32 on the selected site, enter "17" as the starting channel.

Note: When using Custom View Templates for PlusConnect channels, use the same "starting
channel" value that you used in AutoLoad Plus when you set up the PlusConnect.
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The Load Template dialog prompts you for the template and site information necessary to configure your new Custom
View.

Creating Reports
AutoPilot reports allow you to view and archive site data in a readable, professional format. Reports can
contain data from any number of sites, even when each site uses a different type of remote control.
When you create a report in AutoPilot, you are creating a "template" to describe what data a report
should include, and how it should be presented. When you run a report, AutoPilot reads the data
directly from the onboard database. Once you create a report, you can run it any time you need to in
the future without having to make any edits to update data.
Note: For best performance, AutoPilot reports always read data from the computer's local database,
even when SQL Server logging is enabled.
Using the Report Wizard
To create a new report using the Report Wizard, select File  New  Report... in AutoPilot.

Welcome
Click "Next" to start the Wizard.

36

General
Select the desired page orientation. Reports can use portrait or
landscape orientation.
Select the desired sort order for your site data. Data can be
sorted in ascending or descending order.
Select the maximum number of columns to display on page.
Check the "Page break for each day" checkbox if you want each
day's data to begin on a new page.
Set the desired margins for the page layout.
Other options available:
• Include the site name in each column header.
• Set the time format to 24-hour.
• Show high precision time stamps with resolution in
milliseconds.
Select database
A live or archived database can be selected to run reports.
Furthermore, a specific SQL server can be identified to run
reports. Enter the address and database name of the SQL
server.

Date Range
This page allows you to select the dates that will be included in
the report. Because AutoPilot reads from the database each
time you run a report, it will always use the most current data.
There are several ways AutoPilot can filter data by date:
Include all dates
AutoPilot will use all of your logged data. This is not
recommended if you have been logging for a long time.
Show data between...
This option allows you to select specific start and end dates
(inclusive) to include in the report. Because AutoPilot will use
these exact dates, this is useful for "one-off" reports, and not
reports that you intend to reuse.
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Show data from the last...
This option will use range of dates that ends today (the day the
report is run, not the day it is created) and begins a certain
amount of time before today. For example, if you enter "10
Days", the report will include data starting 10 days ago and
ending today.
Show data from the prior...
This option uses an even block of time, ending no later than the
day the report is run. For example, if you enter "1 Week" the
report will include data from last week. This option is useful for
reports that you intend to run on a regular basis, where you
want the date range to fall on even boundaries.
Show this ... to date
This option shows the current block of time (month, week, etc)
up through the current date (the date the report is being run).
For example, if you select "Month" and run the report on April
20, the report will show April 1 through April 20.
Select Sites
Place a checkmark in the list next to each site that you want to
include in the report. You must include at least one site.

Meter Channels
This page allows you to select the meter channels that you
want to include in the report. Meter channel values are
displayed in columns on the report. For best results, limit the
number of meter channels you include in your report to what
will fit cleanly on the page. If there is not enough room for all of
your channels, the report will span multiple pages with different
sets of channels on each page.
To add channels, select the site from the "Site" drop-down and
then select the desired channel(s) in the "Channels" list. Click
"Add" to add the selected channel(s), or click "Add All" to add all
channels.
The channels you have selected appear in the "Selected
Channels" list. You can select channels in this list and click
"Remove" to remove them from the report, or click "Remove
All" to start over.
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Use the "Move Up" and "Move Down" buttons to control the
order in which the channels appear. Your report will use this
order to arrange the meter value columns across the page.
Status Channels
This page allows you to select the status channels that you
want to include in the report. There are a couple of different
ways that status channel values may appear in the report – this
is configured on the next page.
To add channels, select the site from the "Site" drop-down and
then select the desired channel(s) in the "Channels" list. Click
"Add" to add the selected channel(s) or click "Add All" to add all
channels.
The channels you have selected appear in the "Selected
Channels" list. You can select channels in this list and click
"Remove" to remove them from the report or click "Remove
All" to start over.
Channel Settings
Status
Your report can print status values using one or both of two
methods:
Print status when the status value changes
Status messages will appear in the report as events. A message
will print in the report showing the new status value and the
time when it changed. Status channels that remain unchanged
will not print at all.
Print status every time the site is logged
The report will show a line for each status value for every time
when the site was logged. This works best only when a small
number of status channels are included in the report.
Meters
Meter readings will appear all on one line (space permitting)
with the exact time (to the second) of each reading. When a
report comprises multiple sites, this can cause readings to
"stagger" across multiple lines if the timestamps differ at all.
Use one of the following options to optimize your report:
Show all meter readings
This is the default choice and is recommended for single-site
reports.
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Show no more than on reading for every ... minute(s)
This option is recommended when including more than one site
in a report. Meter readings that happen within the specified
period of time are merged onto one line. If two sites log at
slightly different times (for example, 1:00:05 and 1:00:42), this
will prevent the meter readings from breaking up into more
than one line on the report.
Alarms and Events
Select the types of events, alarms, and alarm severities that you
want to include in the report.
If you are using Alarm Relationships, use the "Show subordinate
alarms" checkbox to control whether or not subordinate alarms
are included in the report. If you are not using this feature, this
checkbox is unimportant.
Coloring
Certain kinds of data can be highlighted in color to help call
attention to serious conditions. "Warning" conditions will
appear in orange, and "critical" conditions will appear in red.
Use the checkboxes on this page to specify what kinds of data
should use this coloring feature.

Headers and Footers
If desired, enter a title for your report. This will appear at the
top of the report in large print.
You may also include page numbers, the date range of the
report, and today's date (the date you are running the report,
not the date you created it). For each of the options, you can
specify where on the report/page it will appear.
Additional Header/Footer Text
To further customize the report to suit your needs, you can add
additional text to the top and bottom of each page, the top of
the first page, and the bottom of the last page. For example,
you can a signature line, contact information, station details,
etc.
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Scheduled Printing
You can schedule your report to be printed or emailed
automatically.
For automatic printing, select the printer you want to use.
For email, enter your email address, or a list of addresses
separated by commas (engineer@example.com,
gm@example.com).
Select the date and time you want AutoPilot to print, and the
frequency with which you want it to repeat the print job. Each
time AutoPilot prints this report, it will read current values from
the database.
Note: When using automatic printing, it is strongly recommended
that you not use a specific date range, as this would cause an
identical report to print each time.
Finish
Check "Preview this report" if you want to open a print preview
now.
Click Finish to save your report and close the wizard.

Scheduling Reports
You can schedule reports to automatically print on a regular basis, or have AutoPilot automatically send
a PDF copy of the report to one or more email addresses.
You can configure the report scheduling options using the Report Wizard, or by right-clicking on a
report in the Resources window and choosing "Schedule Report...".
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Report Scheduler dialog

Viewing, Printing and Emailing Reports

AutoPilot requires that you have a default printer configured in Windows,
even if you are only using print preview or PDF reports.
Print Preview
You can open a print preview in a separate window or directly in AutoPilot.
To open a print preview window, select a report from the Resources window or Navigator and click
"Print Preview" from the File menu.
Top open a print preview directly in AutoPilot, double-click the report's icon in the Navigator.
Note: You can configure AutoPilot to run a print preview from the Resources window using a single
click by changing the options in the Options dialog.
Saving to PDF
You can save a report to a PDF file by first opening a print preview and then clicking the "Save to PDF..."
button in the tool bar.

"Save to PDF..." in the print preview tool bar.
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Print Preview Tool Bar
Prints the report after prompting for a printer.
Print…
Saves the report to a PDF file.
Save to PDF…
Page #
Displays the current page number. Typing a number in this field will jump to
that page.
Moves to the first page of the report.
First Page
Moves to the previous page.
Previous Page
Moves to the next page.
Next Page
Moves to the last page of the report.
Last Page
Size
Displays the relative size of the report (% of full size). Only enabled when not
using the "Auto" feature (see below).
Increases the size of the report.
Zoom In
Decreases the size of the report.
Zoom Out
Auto
When enabled, the report is automatically sized to fit the current window.
Turning this feature off allows you to scale the report manually.

Note: The report size settings available in the tool bar have no effect on the printed appearance of
the report.
Printing
To print a report, select the report's icon in the Navigator and click "Print..." from the File menu.
To print from a print preview window, use the "Print..." icon from the print preview tool bar (see above).
To print automatically, see Scheduling Reports (PAGE 41).
Emailing Reports
AutoPilot can automatically email reports to one or more addresses. See Scheduling Reports (PAGE 41)
for more information.
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In Depth
Program Options
The Options dialog allows you to customize and enable many of the features in AutoPilot. Open the
Options dialog by clicking "Options" from the Tools menu.
General
Time Synchronization
To have AutoPilot synchronize the time on each remote
control with the PC's clock, enable Time Synchronization.
Specify the how often you want AutoPilot to perform this
action.
Note: AutoPilot will automatically compensate for any
differences in time zone between the PC and the remote
control.
Connections
Wait ... minute(s) between attempts to reconnect
This setting adjusts how long AutoPilot waits before
attempt to reconnect to a site after a connection was lost.
Prompt to edit network if a site list change is detected
For ARC Plus networks, AutoPilot can notify you if the site
list has changed (sites were added or removed), and
prompt you to use the ARC Plus Network Wizard to make
any edits you may need as a result.
Custom View Folder
Use default Custom View folder
If unchecked, users can specify the directory where they
wish the Custom View files to be stored. The default
location is:
C:\ProgramData\Burk Technology\AutoPilot\Custom Views
Prompt Before Shutting Down
If you enable this feature, AutoPilot will display a
confirmation dialog when you close the program, giving
you a chance to cancel if you were closing by mistake.
Full screen stays on top
When this is checked, Custom Views that are full screen will
always be the top layer. Users will need to exit full screen
mode to access other sections of AutoPilot when this is
checked. To toggle full screen mode either press F11 or
right click on the AutoPilot canvas for a context menu to
toggle full screen mode.

44

Resources
Navigator Selections
Open default view after selecting a site in the Navigator
When checked, AutoPilot will open the Default View for a
site when you single-click on its icon in the Navigator.
Open custom view after selecting in the Navigator
When checked, AutoPilot will open a Custom View when
you single-click on its icon in the Navigator.
Open print preview after selecting a report in the Navigator
When checked, AutoPilot will automatically generate and
display a print preview for a report when you single-click on
its icon in the Navigator.
Always Open Custom Views in a New Window
When checked, all custom views will open in their own
window, rather than in the main AutoPilot window.
Custom Views in a New Window are Full Screen
When enabled, AutoPilot opens Custom Views in a New
Window in full-screen mode.
Open a Custom View on Startup
When enabled, AutoPilot will open the selected Custom
View when the program starts. This is most commonly
used for map or overview displays employed by network
operation centers.
Alarm Notification
For more information on alarm notifications, see Alarm
Notifications (PAGE 12).
Alarm Sound
Enable this feature if you want AutoPilot to play a sound
file when it receives a new alarm from any site.
Optionally, AutoPilot can loop the sound file. You can
specify how long to wait (in milliseconds) between each
iteration of the loop and can have AutoPilot stop looping
the sound after a certain number of minutes.
Email Alarm Notifications
Enable this feature if you want AutoPilot to send an email
to the specified address(es) when a new alarm is received.
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You can choose to receive email notifications on all alarms
or just critical alarms.
To enter a list of addresses, separate each address with a
comma (,) or semicolon (;).
Note: This feature requires correct setup of email settings.
Show New Alarms Dialog
When enabled, AutoPilot will open the New Alarms dialog
when a new alarm is received.
Show Desktop Alert
When enabled, AutoPilot will show a "desktop alert" when
a new alarm is received. The desktop alert displays in the
lower right corner of the screen and fades away after a few
seconds. This is a useful way to display alarm notifications
without interrupting the operator.
Logging
Log hidden channels
When enabled, AutoPilot will log channels even if they are
hidden. Otherwise, AutoPilot will not log data for hidden
channels.
Take a log after a critical alarm
When enabled, AutoPilot will take a telemetry snapshot
after it receives a critical alarm.
Take a log after a warning alarm
When enabled, AutoPilot will take a telemetry snapshot
after it receives a warning alarm.
Wait ... seconds after the alarm before logging
Specifies the number of seconds AutoPilot will wait before
taking a telemetry snapshot after receiving an alarm.
Wait ... minutes before retrying a log if unable to take a log
Specifies the number of minutes AutoPilot will wait before
retrying to take a log on a site when the previous attempt
was unsuccessful.
Use default Log location
When unchecked, users can specify a location to store the
logged data. The default location is:
C:\ProgramData\Burk Technology\AutoPilot\Databases
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Available drives
A list of available drives to select from to store the logged
data.
Maximum log file size
The maximum file size of the log database before AutoPilot
warns you that the file is too big and should be archived.
The default setting is 1024MB.
Note: AutoPilot will always log the alarm. The settings in this
section only affect telemetry logging when alarms occur.
SQL Server
See SQL Server Logging (PAGE 67).

Text File Logging
See Text File Logging (PAGE 65).

Security
Password protect AutoPilot configuration
When checked, AutoPilot will require a password to unlock
configuration settings. For more information, see Security.
Require ctrl+click to issue commands on default views
When checked, AutoPilot will not issue a command from a
Default View unless you hold down the Control key on the
keyboard while clicking. AutoPilot will display a prompt if
you click on a command without holding the Control key.
Note: Requiring ctrl+click on Default Views does not affect
Custom Views. However, each Custom View command can be
configured to require ctrl+click in the Custom View Editor.
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Email
Email settings are required if you plan to use any of the
email features in AutoPilot, such as emailing alarms or PDF
reports.
Note: to enable alarm emails, refer to the Alarm
Notification tab.
If you are unsure of your email settings, consult your
network administrator or Internet Service Provider.
SMTP server
Enter the IP address or host name of your email server.
Port
The port number used by your SMTP server. This is
typically 25.
From address
AutoPilot will use this for the "from address" field in email
messages. This setting is not critical but may affect how a
spam filter treats messages sent by the software.
Use authentication
Check this box if your SMTP server requires a user name
and password, and enter those values in the fields beneath
the checkbox.
Use SSL / TLS
Check this box if your SMTP server requires SSL or TLS
encryption. Typically, SMTP ports of 465 and 587 require
SSL/TLS encryption.
Jet
Jet options control the timing and behavior of Jet Active
Flowcharts.
Delay Jet startup for [n] seconds.
When AutoPilot starts, it will delay running Jet Active
Flowcharts for the specified number of seconds. Note that
you can still run flowcharts manually before Jet starts
running.
Leave sites connected after use for [n] seconds.
Jet will automatically connect to sites as needed. When no
further interaction is required with a particular site, Jet will
disconnect from that site after the specified number of
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seconds. Note that Jet will not disconnect sites that are
connected automatically at startup or connected manually.
Wait [n] ms before requesting new status/value.
When requesting a new status or value from a site, Jet will
wait the specified number of milliseconds before polling for
data. This allows time for the site's readings to update.
Allow up to [n] ms for Jet to receive a response from a site.
Jet will wait up to the specified number of milliseconds to
receive a response from a site when it polls for data. If the
site does not respond in the time allowed, the flowchart
will show an error.
Poll for new data if readings are older than [n] seconds.
When Jet requires site data, it will use the last known value
from the site. If the last known value was received more
than [n] seconds ago, Jet will poll for new data. Note that
Jet will always poll when using the "New Status" and "New
Value" commands.

Licensing
To add license keys for AutoPilot add-ons, or to use a demo key, access the Licensing dialog from the
Help menu.
Note: The Licensing dialog is only used for add-ons and demos. You do not need to enter your remote
control's authorization code in this dialog.

Licensing Dialog

To add a new license, click New License. AutoPilot will prompt you for your company name and license
key.
After you enter a license key it will take effect immediately (you do not need to restart the software).
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Note: Each license key you add to AutoPilot must be for the same company name.
Although it is not normally necessary to remove a license key, you can do so by selecting the license
from the list and clicking the Delete button.
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Connectivity
Connection Methods
AutoPilot supports the following connection methods giving users an indication on the type of
connection to the ARC systems.
Connected
Warp Engine connection
Not connected
Connected

Full connection using the TCP/IP protocol or Arcadia
Efficient low bandwidth protocol (UDP) via the Burk
Technology Warp Engine.
No connection established with the site.
Full TCP connection to Redis database for Arcadia NOC
Connections.

Connecting and Disconnecting
To connect to, or disconnect from, any site, select its icon in the Resources window or Navigator and
use the appropriate option from the main menu, tool bar, or context menu (accessed by right-clicking
on the site icon). These options are explained below:
Connect
Connect As…
Connect to Backup

Disconnect

AutoPilot will connect using the primary connection settings.
AutoPilot will prompt you for connection settings and a user name and
password before connecting.
AutoPilot will connect using the backup connection settings. AutoPilot
will not switch to a primary connection when you manually establish a
backup connection in this manner.
AutoPilot will disconnect from the site. AutoPilot will not restore this
connection after you manually disconnect.

Note: If you have configured a site to not save the password, AutoPilot will always prompt for a
password when connecting to that site.
Connection Details Dialog
The Connection Details dialog shows connection statistics and other data about your sites. To access
this dialog, select a site in the Resources window or Navigator and click "Connection Details" from the
File menu.
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Connection Details dialog for an ARC Plus

The Connection Details dialog shows the following parameters, depending on what remote control you
are connected to:
For All Remote Controls
Connected via
The IP address or host name plus TCP port.
Connected since
The date and time the connection was established.

ARC Plus
User
Serial number
Firmware version

Connection Statistics
Data Sent
Total bytes
Total packets
MS since last

Data Received
Total bytes
Total packets
Bad bytes
Bad packets

The user name that is logged onto this site.
The serial number of the remote control unit.
The version of firmware running on the remote control unit.

The total number of bytes sent from AutoPilot to the site.
The total number of packets sent from AutoPilot to the site.
The number of milliseconds since AutoPilot last sent a packet to the site.

The total number of bytes sent from the site to AutoPilot.
The total number of packets sent from the site to AutoPilot.
The number of bytes received from the site that AutoPilot could not parse
into a valid packet.
The number of packets received from the site that AutoPilot could not
interpret as valid.
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MS since last

The number of milliseconds since AutoPilot last received a valid packet from
the site

Site Configuration Cache
AutoPilot saves a copy of your ARC Plus and ARC Solo site configuration files in its onboard cache. This
allows AutoPilot to avoid downloading site configuration when it already has the current files.
Although it is never necessary to do so, you can clear these cache files by selecting "Clear Saved Site
Configuration" from the File menu.
Note: After clearing the site configuration cache, you must restart AutoPilot before your ARC Plus or
ARC Solo sites will respond to this change.
Sync Configuration
You can update AutoPilot’s cached configuration by right-clicking on a site in the Resources window or
Navigator and selecting “Sync Configuration”
Backup Connections and Automatic Reconnection
AutoPilot has several built-in options to help you stay connected to your sites 24x7.
Terminology
Primary Connection
Backup Connection
Automatic Connection

Connection Recovery

Retrying a Connection

Manual Connection
Manual Disconnection

Your primary connection to a site is the connection that you consider
"normal" and will use in most cases.
A backup connection is an alternative method that AutoPilot can use to
connect to a site.
A connection is automatic when AutoPilot connected without requiring
any user interaction. When a site is configured to connect at startup,
AutoPilot will automatically connect to it when the program starts.
When a connection is lost, AutoPilot will first attempt to recover it.
AutoPilot does this immediately after a connection loss. If the
connection is recovered successfully, AutoPilot will not note a warning
in the Application Event List.
Except under certain circumstances (explained below), AutoPilot will
retry a connection periodically after a connection loss. This happens
only after connection recovery is unsuccessful (see above).
Whenever you connect to a site by clicking one of the connect icons, you
are connecting manually.
Whenever you disconnect from a site by clicking the disconnect icon,
you are disconnecting manually.

Automatically Reconnecting After a Connection is Dropped
AutoPilot will automatically reconnect to a site after a connection is lost. There are two phases to this
process:
1. AutoPilot will attempt to recover the connection immediately. If this is successful, AutoPilot
will not log a warning in the Application Event List.
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2. AutoPilot will periodically retry the connection. The timing of this process is adjustable using
the Options dialog.
Note: If a connection recovery is unsuccessful, AutoPilot will log a warning in the Application Event
List. AutoPilot will not log additional warnings if reconnection attempts are unsuccessful, as this
would "flood" the log over a period of time.
If a connection is restored but then lost again, AutoPilot will log a warning again.
AutoPilot will not reconnect to a site under the following circumstances:
•
•
•

You manually disconnected from a site.
You connected to a site using "Connect As...".
Your site is configured to prompt for a password.

Switching to a Backup Connection
You can configure sites in AutoPilot to use a backup connection. AutoPilot will use the backup
connection in the event that the primary connection is lost and cannot be restored.
Restoring the Primary Connection
Optionally, AutoPilot can periodically try to restore the primary connection. If this is not successful,
AutoPilot will return to the backup connection. AutoPilot will repeat this process until the primary
connection is successfully restored.
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Automatic Connection Flowchart
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Remote Control Specific Information
ARC Plus
PlusBus Status
To access the PlusBus Status dialog, select an ARC Plus site in the Resources window or Navigator and
click "PlusBus Status" from the File menu.

PlusBus Status dialog

Fields
Device
Channels
Status

The type of device on the PlusBus (Integrated Input Unit or Integrated Command
Relay)
The range of channel numbers this device is occupying.
The status of this device on the PlusBus (OK or Missing)
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Warp Engine™ Polling
The previous section described the process of establishing connections to ARC Plus and ARC Solo
remote control units. While connected, all status and meter channels in the remote control unit are
available for display in AutoPilot default views and custom views.

Default View of a Connected Site

The AutoPilot Warp Engine provides an alternative option for monitoring Version 5 ARC Plus Touch or
SL units with firmware 5.0.3.5 or later and ARC Solo units with firmware 1.0.29 or later. Warp Engine
polling is fast, enabling real-time monitoring and reporting for all selected status, meter and command
channels.
Warp Engine polling is efficient in its use of communications bandwidth. It uses very small packets,
sending only required data and minimizing communications overhead. Polling 32 parameters from 100
sites requires only 37,800 bytes per second of IP capacity at the central site, and only 378 bytes per
second at each remote site. If communications bandwidth is at a premium cost, it can be further
reduced by selection of a slower polling rate.
To configure Warp Engine polling, right-click a connected ARC Plus or ARC Solo site in the Resources
window or Navigator -> click Warp Engine™ Polling.

57

Warp Engine Polling Menu Choice

The Configure Warp Engine Polling dialog box will be displayed:

Configuring Warp EngineTM Polling

Click the Enable Warp Engine ™ Polling checkbox, select a Poll Rate and select the metering and status
channels you want to poll with Warp Engine. It is not necessary to select command channels. By
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default, all command channels are active with Warp Engine. User alarm messages configured using
AutoPilot are also received over sites connected via Warp Engine.
To enable Warp Engine, you must disconnect from the site. From the File menu, select Disconnect or
click on the disconnect icon
. Metering and status channels selected for Warp Engine Polling and all
configured command channels will appear in color.

Meters, Status and Commands Shown in Color
Click on the Download Alarm Details checkbox if a full alarm log for the site is desired. If this box is
checked, each time Warp Engine detects that an alarm has occurred it will briefly establish a full
connection to the site to download the alarm information. When the download is completed, the
connection is automatically dropped and Warp Engine polling resumes.
It is necessary to establish a connection to each ARC Plus or ARC Solo at least once prior to enabling
Warp Engine polling for that system. This allows AutoPilot to download channel and configuration
information from each system, and to establish credentials for secure Warp Engine communications.
ARC Solo systems must be enabled for Warp Engine Polling via the ARC Solo web-browser interface.
Navigate to the System->Warp Engine page and select the “Enable Warp Engine Polling” checkbox.
See the ARC Solo User Guide for additional information.
Note: Warp Engine polls all site alarm conditions regardless of which channels are being actively
polled.
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Alarm Management
Network Alarm List
To view alarms from a single network only, right-click on the network's icon in the Resources window
and select "Network Alarms".
The network alarm list displays all the uncleared alarms for the selected network.

Network Alarm List

Site Alarm List
To view alarms from a single site only, right-click on the site's icon in the Resources window or
Navigator and select "Site Alarms".
The site alarm list displays all the uncleared alarms for the selected site.

Site Alarm List

Notifications and Sounds
AutoPilot can notify you of new alarms in several ways, described below:
Alarm List
The Alarm List is the main place where AutoPilot displays information about alarms. New alarms are
differentiated by their icon ().
For more information on the Alarm List, see Alarms Overview (PAGE 9).

Alarm List
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New Alarms Dialog
The New Alarms dialog, enabled using the Options dialog, will pop up whenever a new alarm occurs.

New Alarm Dialog

If there is more than one new alarm, the New Alarms dialog will show all of the new alarms.
Clicking on an alarm in the list will display more information about the alarm at the top of the dialog.
Clicking "Clear" will clear the selected alarm.
New Alarm Desktop Alert
A "desktop alert" is a small notification that appears in the lower right corner of the screen. The
notification will automatically disappear after a few seconds. This kind of notification is a useful way to
make an operator aware of new alarm condition with causing an interruption.

New Alarm Desktop Alert

Hovering over the desktop alert will prevent it from closing.
Clicking the "Clear Alarm" icon (

) in the lower left corner of the alert will clear the alarm.

Sounds
If desired, AutoPilot can play a sound when a new alarm is received. This option is configured in the
Options dialog.
Alarm Relationships
Alarm Relationships allow you to define cause and effect relationships between different alarm
conditions.
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For example, a loss of power may also cause a transmitter to power down, which in turn may cause a
"low power" alarm. By defining the relationships between these conditions, AutoPilot can focus the
operator's attention on the root cause condition, facilitating speedier problem resolution.
To set up Alarm Relationships, click "Alarm Relationships..." in the Tools menu.

Alarm Relationships dialog

Every alarm relationship comprises one root alarm and one or more subordinate alarms. When a root
alarm and subordinate alarm occur at the same time, AutoPilot will hide the subordinate condition.
When a subordinate alarm occurs by itself (without the root alarm), AutoPilot will treat it normally and
does not hide it.
Note: You can still view subordinate alarm conditions in the Alarm List. See Alarms Overview (PAGE
9) for more information.
Cascading Alarm Relationships
It is possible for root and subordinate alarms to "cascade", where a subordinate alarm is also a root
alarm with its own subordinates. For example, an alarm for an off air condition may be a subordinate of
a power loss alarm, but may itself cause a low power alarm. In this case the off air alarm is also a root
alarm.
To configure cascading alarm relationships, simply add the appropriate condition as a new root alarm
and add its subordinates under it. AutoPilot will automatically hide both the original subordinate as well
as its subordinate when the highest level root alarm is present.
Alarm Window
When related alarms occur, there may be some delay between the root alarm and the subordinate
alarms that it causes. In some cases, the subordinate alarms may occur after the root alarm, and in
other cases they may happen before it.
AutoPilot allows you to control the window of time around the root alarm in which subordinate
conditions are considered to have been caused by the root alarm condition. This is called the alarm
window.
The pre-alarm window specifies the number of seconds before the root alarm during which time a
subordinate alarm is counted as such.
The post-alarm window specifies the number of seconds after the root alarm during which time a
subordinate alarm is counted as such.
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Alarm Relationships Dialog Tool Bar
To add and edit alarm relationships, use following buttons found on the Alarm Relationships tool bar:
Save
Add Root Alarm
Add Subordinate Alarm
Remove Root Alarm
Remove Subordinate Alarm
Close

Saves your alarm relationships.
Creates a new root alarm in the Alarm Relationships grid.
Adds a new subordinate alarm under the selected root alarm.
Removes the selected root alarm and all of its subordinates.
Removes the selected subordinate alarm.
Closes the Alarm Relationships dialog.

Alarm Relationships Grid Fields
[Row Type]
This column identifies the type of row using an icon:
Root alarm
Subordinate alarm
Network
Site
Alarm Type
Channel
Pre-Alarm Window (sec)
Post-Alarm Window (sec)

Select the network containing the channel you want to use for this
row.
Select the site containing the channel you want to use for this row.
Select the alarm type (status or a metering limit) that you want to use
for this alarm definition.
Select the channel whose alarm you are using for this row.
Enter the number of seconds that AutoPilot should use for the prealarm window (Subordinate rows only).
Enter the number of seconds that AutoPilot should use for the postalarm window (Subordinate rows only).

Alarm Muting
The Alarm Muting dialog allows you to access the alarm muting feature of the ARC Plus. To open the
Alarm Muting dialog, click "Alarm Muting" from the Tools menu.

Alarm Muting dialog

63

To turn alarm monitoring on and off for the entire site, use the "Site Limits Monitoring" checkbox.
When this box is checked, alarm monitoring is enabled.
To mute individual channels, place a checkmark next to the desired channel on the Muted Meter
Channels or Muted Status Channels tab.
Your settings will go into effect when you click OK or Apply.

Logging
AutoPilot logs the following types of data:
•
•
•
•

Telemetry (meter and status readings)
Status changes
Alarms
Events

Enabling Logging
AutoPilot will always log alarms and events for all sites. Telemetry logging is enabled individually for
each site, and can be enabled/disabled for the entire application.
When logging for the application is disabled, AutoPilot will not log telemetry on any sites. When
enabled, AutoPilot will log telemetry on all sites for which logging is enabled at the site level.
To enable logging for AutoPilot, click "Enable Logging" from the Tools menu.
To adjust logging settings for a site, right-click on the site's icon in the Resources window or Navigator
and select "Configure Logging...".

Logging Configuration Dialog
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Logging and Connections
If you are not connected to a site that is due to be logged, AutoPilot will automatically connect to the
site for you. When AutoPilot is finished logging the site, it will automatically disconnect.
Note: Logging will never cause AutoPilot to disconnect from a site that was already connected.
Logging on Demand
To force AutoPilot to immediately take a log, click "Log Now" from the tools menu.
Note: You must already be connected to a site to use the "Log Now" feature.
Databases
Onboard Database
AutoPilot stores its logs and captures in the onboard database. AutoPilot always logs to the onboard
database, even when other databases are enabled (see below).
For more information on exporting and archiving your logged data, see Data Management (PAGE 72).
The onboard log uses an SQLite Database format. When AutoPilot starts up, it will create this file
automatically if it does not already exist.
The onboard database file is located here:
Windows 8 and Windows 10:
%AllUsersProfile%\Burk Technology\AutoPilot\Databases\Log.db

While it is possible to open this file using a third-party SQL browser, it is
strongly recommended that you instead export your data or use Text File
Logging.

Never open this file while AutoPilot is running.
Other Databases
In addition to the onboard log, AutoPilot can optionally be configured to use one or both of the
following types of logs:
•
•

Text File Logging (SEE PAGE 65)
SQL Server Logging (SEE PAGE 67)

Text File Logging
In addition to using the onboard database, AutoPilot can log to a simple text file. This is often useful
when integrating log data with 3rd party applications.
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Text File Logging will create a log file in the following location:
Windows 8 and Windows 10:
%AllUsersProfile%\Burk Technology\AutoPilot\Logs

Each site will have its own file. The file name is generated automatically, and follows the following
format:
[Network Name] - [Site Name] ([Unit ID])

When AutoPilot automatically archives a Text File Log (see below), the archive file will be stored in the
following location:
Windows 8 and Windows 10:
%AllUsersProfile%\Burk Technology\AutoPilot\Logs\Archive

To enable and configure Text File Logging, use the Options dialog.
You must restart AutoPilot after enabling or disabling Text File Logging
before your changes will go into effect.

Text File Logging Settings in the Options Dialog

The following parameters are available:
Enable text file logging
Comma separated values
Tab separated values

Use this checkbox to turn Text File Logging on and off
Select this option to have AutoPilot write to the text file using
commas to separate each field.
Select this option to have AutoPilot write to the text file using
tabs to separate each field.
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File Maintenance Options
Never delete or archive log files
Automatically delete log files
Automatically archive log files
Delete / archive files after...

AutoPilot will not perform any file maintenance tasks. You may
delete/archive files manually in Windows if desired.
AutoPilot will delete your log files according to the specified
schedule.
AutoPilot will move your log files to the archive location (see
above) according to the specified schedule.
AutoPilot will delete or archive files after they have reached the
specified age.

File maintenance is strongly recommended. Letting a Text File Log grow
too large may cause performance problems in AutoPilot or in 3rd party
applications.

SQL Server Logging
In addition to using the onboard database, AutoPilot can log to a server running Microsoft SQL Server.
This is often useful for organizations running multiple AutoPilot logging computers and can also be
used to integrate AutoPilot's logged data with other databases used throughout the operation.
For information on what tables and fields are included in the AutoPilot SQL Server database, see
Database Schema (PAGE 106).
To enable and configure SQL Server Logging, use the Options dialog.
It is strongly recommended that you contact your database administrator
before configuring SQL Server Logging in AutoPilot.

You must restart AutoPilot after enabling or disabling SQL Server
Logging before your changes will go into effect.
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SQL Server Logging settings in the Options dialog

The following parameters are available:
Log using SQL Server
Server address
Database

Use integrated Windows security
Specify a user name and
password

Check this box to enable/disable SQL Server logging.
The host name or IP address of the computer running
Microsoft SQL Server.
The name of the AutoPilot database on your SQL Server. Use
the drop-down list to select an existing AutoPilot database.
See below for instructions on how to create a new database.
Select this option if your Windows user account has
permission to write to the AutoPilot database.
Select this option and enter your user name and password to
use a specific account on the SQL Server.

Note: Your account must have permission to read and write to the AutoPilot database. Consult your
database administrator to make sure you have the correct permissions.
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Creating a New Database on the SQL Server
There are two ways you can create a new database on the SQL Server for AutoPilot.
Let AutoPilot Create a Database
1. Open the SQL Server tab in the Options dialog (see above).
2. Enter your server address and security information.
3. Enter the desired name for the AutoPilot database in the "Database" field.
4. Click the "New" button. AutoPilot will automatically create your database.
A message box will confirm that this was successful, or state what error caused it to fail.
Use the Supplied SQL Script
AutoPilot ships with a .sql script that a database administrator can use to create a new database. The
script is found here:
%ProgramFiles%\Burk Technology\AutoPilot\AutoPilot.sql
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Captures
The Captures feature, available on ARC Plus Touch and SL units with firmware 5.0.8.1 or newer, allows
you to configure the ARC Plus to store periodic captures (snapshots) of a specified range of channel
values locally on The ARC Plus. You can create a download schedule on any AutoPilot system to
automatically retrieve the captures. Captures and logs are stored in the same onboard database and are
displayed in the Logged Data View.
Enabling Capture Downloading
Select “Enable Logging” from the Tools menu.

Tools>Enable Logging

If you are not connected to a site that is due for a download, AutoPilot will automatically connect to the
site for you. When AutoPilot is finished downloading from the site, it will automatically disconnect.
Configuring the Download Schedule
1. Select “Configure Logging” from the Edit menu.
2. Enable the “Download Captures from this site” checkbox.

Edit>Logging

3. Specify the download “Interval” (the frequency, in minutes or hours, at which AutoPilot will
download its next captures from the ARC Plus).
4. Specify the “Next download” (the time of day when AutoPilot will download its next set of
captures).
5. Click “OK”.
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Note: If AutoPilot fails to take a log or download captures, it waits 10 minutes and then tries again.
You can configure the waiting interval in Tools > Options > Logging.
Taking an Immediate Capture
In addition to the captures scheduled to be performed automatically on the ARC Plus, you can perform
an immediate capture from the remote AutoPilot system. This capture is stored on the ARC Plus
system and downloaded to AutoPilot as specified in the download interval

Tools>Take Capture

Viewing Captures
Captures appear in the Logged Data View. See Logged Data View(PAGE 6).
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Data Management
Exporting Data
AutoPilot has a built-in export feature that allows you to export your logged data in a variety of
different formats, each suitable for analysis in 3rd party applications.
To export your data, click "Export Logged Data..." in the Tools menu.

Export dialog

The following options are available on the Export dialog:
Format
Data
Network
Site
Start date
End date
Convert times
to local time
zone

AutoPilot supports the following formats: Excel, CSV (comma separated values),
Tab (tab delimited values), and XML (extensible markup language).
Select the database table that you want to export: Telemetry, Alarms, Events, or
Status Changes.
Choose the network whose data you want to export, or choose "All Networks".
Choose the site whose data you want to export, or choose "All Sites"
Check the "Start date" checkbox and select a date if you want to export data only
from dates on or after the selected date.
Check the "End date" checkbox and select a date if you want to export data only
from dates on or before the selected date.
When this option is checked, AutoPilot will convert all timestamps to use the
local time zone instead of UTC.

Note: Exporting data does not remove it from the database.
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Archiving Data
Over time and depending on the number of sites you have added to AutoPilot, your onboard database
may grow very large. Archiving data will remove it from the database and store in an archive file that
you can access later.
While the technical limit to the size of the database is 2GB, it is highly
recommended that you periodically archive your data to optimize
performance.

To archive your data, click "Archive Logged Data..." in the Tools menu.

Archive Data dialog

Enter the date that you want to use to archive your data. Any data older than this date will be removed
from the database and stored in the archive.
Archived data is stored in XML format. AutoPilot will prompt you for the location where you want to
store this file.

Security
Security Overview
Password Encryption
There are several places throughout AutoPilot where the software will prompt you for a password.
AutoPilot never stores your passwords in "plain text". Passwords are encrypted using standard
encryption methods whenever it is necessary to save to a file.
Remote Control Permissions
Your remote control has built-in security mechanisms, varying by model. Remote control security
prevents unauthorized users from reading your data or issuing commands.
Maintenance Mode
Your remote control also has a "maintenance mode" or "remote/local" mode feature. This feature locks
out remote commands for safety reasons during maintenance operations. The remote control will not
permit AutoPilot to issue commands when in maintenance mode.
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Note: AutoPilot will gray out commands that are unavailable due to insufficient permissions or
maintenance mode.
Even if a command were to appear available, the remote control itself would not allow AutoPilot to
issue the command.
Locking AutoPilot Configuration
If desired, you can password protect AutoPilot's configuration options. This is useful to prevent
operators from making undesired changes.
To enable this feature, use the "Security" tab in the Options dialog.
Once you have enabled password protection and set a password, click "Lock AutoPilot Configuration" in
the File menu to lock or unlock the configuration.

Unlock Configuration password prompt

Application Event List
AutoPilot logs various activities using the Windows Application Event Log. While you can access this log
directly in Windows, AutoPilot makes it available in the program as well.
To access the Application Event List, click "Application Event List" from the View menu.

Application Event List
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To see more information about an event, double-click on its entry in the event list.

Application Event details

Note: The Application Event dialog includes a "Copy" button that will copy the event details to the
clipboard. You can then paste this information into a file or email.
There are three types of events logged in the list:
Information
Warning
Error

Information events are a record of some of the regular operations that AutoPilot
performs. These events are normal, and do not indicate any kind of a problem.
Warning events indicate that an operation was unsuccessful, due to foreseeable
circumstances (such as a connection loss).
An error condition is an abnormal failure. Under normal circumstances, error
conditions should never occur.

Note: AutoPilot will notify you of new Error conditions by showing an icon in the Status Bar.

Migration
Migrating your AutoPilot installation from one computer to another – or cloning your configuration for
use on second PC – is relatively easy. All of your files are stored in one folder on the computer:
Windows 8 and Windows 10:
%AllUsersProfile%\Burk Technology\AutoPilot

To completely clone your installation onto another computer, simply copy the files from this folder
onto the new computer. If desired, you may copy only certain files. See below for more information.
You must still install AutoPilot on your new computer. Copying this
folder does not install the software for you.

AutoPilot Files and Folders
Folders
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Cache
Custom Views
Databases
Jet
Licensing
Logs
Reports
Settings

The cache folder stores local copies of your site configuration. These files can be
safely deleted or omitted during data migration.
This folder contains all of your Custom View files
This folder contains your onboard logging and captures database (Log.db). If you
delete or omit this file, AutoPilot will create a new one on startup.
This folder contains your Jet™ Active Flowcharts for AutoPilot as well as your
Virtual Channels.
This folder contains your licensing information for add-ons and demos.
This folder contains your Text File Logs (if enabled).
This folder contains your report files.
This folder contains various files that store settings, sites, etc. See below for more
details.

Settings Files
The following files are found in the Settings folder (see above). If you delete one of these files, or omit it
during data migration, AutoPilot will create a new – blank – copy.
cfgsec.dat
NetworkDevices.xml
Networks.xml

This file stores a one-way hash of your configuration password (if you
have set one). See Security for more information.
This stores your Network Devices.
This stores your site data.
This is the most critical file to copy when cloning your setup.

SubordinateAlarms.xml

This stores your Alarm Relationships configuration.

Network Names
If you plan to share Custom Views or other site-related data between multiple computers, it is
important that you use the same network name on each computer for your sites. AutoPilot uses
the network name to identify your sites.
Note: You can rename a network within AutoPilot. AutoPilot will display a prompt asking if you want
to update your Custom Views, etc.
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Jet
Jet Active Flowcharts
Jet Active Flowcharts allow you to describe automatic remote control functionality using simple, easy
to read flowcharts.
Licensing
To purchase a license for Jet, please contact Burk Technology at 978-486-0086, or via email at
sales@burk.com.
Active Flowcharts for AutoPilot
Jet™ Active Flowcharts for AutoPilot allow you to control any site or Network Device in AutoPilot.
To run an Active Flowchart in AutoPilot, use the Jet Status window.
Jet Active Flowcharts for AutoPilot will only run when AutoPilot is
running.
Starting Jet
To start Jet, select Jet from the Tools menu in AutoPilot.
Note: If you have not installed your license for Jet Active Flowcharts, please do so now.
See Licensing (PAGE 49) for more information.
Create a New Flowchart
From the Jet Designer, select New from the File menu. Jet will prompt you for a flowchart target.
Choose the "Run this flowchart in AutoPilot" option.

Flowchart target

77

Saving the Flowchart
After designing your flowchart, click Save from the File menu to save your flowchart. Enter a file name
for this flowchart. AutoPilot will use the file name to identify this flowchart.
Jet will only run flowcharts from the Jet directory. Do not save flowcharts
in any other location.

Saving a flowchart that is running will cause Jet to stop the flowchart. If
the flowchart is not scheduled to run, you will need to restart it manually.
Opening an Existing Flowchart
To open an existing AutoPilot Active Flowchart, click AutoPilot Active Flowchart... from the Open
submenu under the File menu.
Calendars
You can schedule flowcharts to run at different calendar times. Jet allows you to define multiple
calendars. To add, remove or edit a calendar, click Manage Calendars... from the Tools menu in Jet.

Jet Calendars

New Calendar
Save
Delete Calendar
Calendar
Close

Creates a new calendar.
Saves changes made to the selected calendar.
Deletes the selected calendar.
Select a calendar from the drop down list to display it in the editor.
Closes the calendar editor.

Note: Jet calendar times are always in Standard Time for the time zone configured on the PC.
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Error Handling
To specify how Jet should respond should a flowchart experience an error, click Error Handling... on the
File menu.

Error Handling

Options
Stop the flowchart

Restart the flowchart
Email an error report

If the flowchart experiences an error, Jet will stop the flowchart. Jet will not
run the flowchart again unless it is scheduled to run later, or if you run it
manually.
If the flowchart experiences an error, Jet will restart the flowchart after
waiting for the specified number of seconds.
When this option is checked, Jet will email the specified email address if
the flowchart experiences an error.

Active Flowcharts for ARC Plus and ARC Solo
Jet™ Active Flowcharts for ARC Plus run as macros on the ARC Plus. You can run flowcharts on the ARC
Plus the same way you can run macros (AutoPilot, front panel, ESI, RSI, Web Interface, etc).
Active Flowcharts on the ARC Plus cannot be edited using the Macro
Editor in AutoLoad Plus.

Note: Jet requires ARC Plus firmware 2.2 or newer. To obtain the latest ARC Plus firmware, visit
www.burk.com.
Jet™ Active Flowcharts for ARC Solo are run as macros on the ARC Solo. You can run flowcharts on the
ARC Solo from AutoPilot or from the ARC Solo RSI or Web Interface.
Starting Jet
To start Jet, select Jet from the Tools menu in AutoPilot.
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Note: If you have not installed your license for Jet Active Flowcharts, please do so now. Licensing is
not required for creation of Active Flowcharts on the ARC Solo.
See Licensing (PAGE 49) for more information.
Create a New Flowchart
From the Jet Designer, select New from the File menu. Jet will prompt you for a flowchart target.
Choose the "Run this flowchart on an ARC Plus" option or the "Run this flowchart on an ARC Solo" and
select the network and site for which you want to create a new flowchart.

Flowchart target

Saving the Flowchart
After designing your flowchart, click Save from the File menu to save your flowchart. Select the macro
location where you want to save the flowchart and give it a name.

Save a flowchart to an ARC Plus
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Opening an Existing Flowchart on ARC Plus or ARC Solo
To open an existing Active Flowchart, click ARC Plus or ARC Solo Active Flowchart... from the Open
submenu under the File menu. Select the network and site, and then select the desired flowchart.

Open a flowchart on an ARC Plus

Open a flowchart on an ARC Solo

Designing Active Flowcharts
Flowchart Components
Flowchart components are objects that you can add to the flowchart's canvas. The following
components are available for use in Jet:
Start Flowchart
End Flowchart
Action
Conditional

Line Joint

Junction

Specifies the beginning of a flowchart. All flowcharts must have a start.
Specifies where the flowchart stops running. Flowcharts may have more than
one end, or no end if execution should continuously.
A flowchart action performs an operation and then moves to the next object.
Actions always have one output.
A conditional move to either of two objects, depending on whether the
condition evaluates to true (T) or false (F). Conditionals always have two
outputs.
Line joints are used to route flowchart lines around the canvas of the
flowchart. Using line joints is optional. Line joints do not affect the
functionality of a flowchart.
Junctions allow multiple output lines to converge on a single target. Junctions
are useful for making the intention of the flowchart clear, but do not affect
functionality. Using junctions is optional, as multiple lines can be connected to
a single target without using a junction.
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Adding and Connecting Components
Adding Components to the Canvas
To add a component to a flowchart, simply drag it from the Toolbox and drop it onto the canvas. You
can click and drag a component on the canvas to move it around. Use the sizing handles to resize it as
desired.
Note: Remember to add a Start object to your flowchart. All flowcharts require a start.
Drawing Lines to Connect Components
Drawing lines between flowchart components instructs the flowchart to execute conditions and actions
in the desired order.
To draw a line connecting two components, hover over the first component to bring up the connection
arrows.

Connection arrows

Note: One connection point cannot serve as both an input and an output. When used as inputs,
multiple connections may share the same point. When used as outputs, each connection can only
support one connection.
Flowchart lines may start and end at any of the arrow positions displayed. Hover over the desired arrow
and note that it turns dark red to indicate that it is selected. To begin drawing a line, click and hold the
mouse, then drag the mouse to the desired target object. Hover over the target object (with the mouse
button still held down) to display its input selection arrows. Hover over the desired arrow (note that it
turns dark red) and release the mouse button. Jet will draw a line between the two objects using the
points you selected.
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Connected flowchart objects

Note: If desired, a line can connect an object back to itself. This instructs the flowchart to execute the
component continuously in a loop. Carefully consider what you want the flowchart to do when using
this technique.
Connecting Conditionals
Conditionals always have two outputs: one for the "True" condition, and one for the "False". The first
line you draw out of a conditional is for the True condition. True conditions are identified with a "T", and
false conditions with an "F".

The "T" and "F" connections for a conditional
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Configuring Component Settings
Each action and conditional component is configurable for a wide variety of operations. To configure a
component, click on it to select it, and use the Properties tool window.

Flowchart component properties

Once you have configured the component's properties, it will show a description of its settings on the
canvas.

A flowchart component with its properties set

Using Line Joints and Junctions
Line Joints
Routed lines on the flowchart canvas automatically create a path between two objects. There may be
times when this path conflicts with other objects on the canvas or is otherwise undesirable. The line
joint allows you to route a line along a specific path. To use the line joint, drag and drop it onto the
canvas and connect it as you would any other component. When the line is selected, the line joint will
display a small green dot. When the line is not selected, the line joint will be invisible.
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A line joint

Note: The line joint does not add any functionality to the flowchart.
Note: Jet will automatically create line joints for you when you are drawing lines if you drop the line
on the canvas instead of connecting it to another component.
Junctions
Junctions are a convenient way to connect the output lines from multiple components to a single input.
The junction does not add any functionality to the flowchart — it simply makes the intention more
clear.

A junction

Note: Using junctions for many-to-one connection is not required. If desired, you can connect multiple
objects directly to a single destination. The junction is purely for convenience and readability.
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Line Types
Jet supports two types of lines for connecting components together. To choose a line type, select it
from the Tools menu.
Straight Line
Routed Line

A straight line is drawn directly from one point to another.
Routed lines use right angles to draw a path between two objects.

Scheduling Active Flowcharts
To schedule a flowchart, select the Schedule... option from the File menu.

Schedule

Run on demand
Run at startup
Run at an interval
Schedule for a specific time
Schedule for a calendar time

The flowchart will only run when executed specifically. It will not
run automatically.
The flowchart will run when the system starts up.
The flowchart will run periodically at the specified interval.
The flowchart will run daily at the specified time.
The flowchart will run daily at the specified calendar time.

Note: Active Flowcharts for AutoPilot include an additional option to select from multiple calendars.
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Jet Status
The Jet Status window in AutoPilot allows you to run, stop and view the status of your Active
Flowcharts for AutoPilot.

Jet Status

Note: The Jet Status window only shows Active Flowcharts for AutoPilot. Active Flowcharts for ARC
Plus and ARC Solo appear as Macros in the Macro List.
Tool Bar Icons
Run

Runs the selected Active Flowchart.

Stop
New

Stops the selected Active Flowchart.
Create a new Active Flowchart for AutoPilot.

Edit

Opens the selected Active Flowchart in the editor.

Context Menu Icons
In addition to the tool bar icons above, the following items are available by right-clicking on a flowchart
in the status window.
Delete
Rename
Properties

Deletes the selected Active Flowchart.
Allows you to rename the selected Active Flowchart.
Displays the properties of the selected Active Flowchart, including the time the
flowchart last ran, and additional information about the most recent error the
flowchart reported (if any).
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Status Icons
When a flowchart is running or scheduled to run, the status window will display an icon next to the
flowchart to indicate its status. Flowcharts that are not running and not scheduled to run will display no
icon.
Running
Reading Data
Waiting
Scheduled
Error

The flowchart is currently running.
The flowchart is reading data from a site.
The flowchart is running a Wait command.
The flowchart is not running but is scheduled to run in the future.
The flowchart reported an error on its last execution. Right-click on the
flowchart and choose Properties for more information.

Virtual Channels
Overview
Virtual Channels allow you to create new channel values using real channels, operators and functions.
Virtual Channels are a useful way to add calculated channel data such as VSWR and efficiency, as well
as complex status indicators that combine the values of multiple channels and conditions.
Licensing
Virtual Channels are a part of Jet™. To purchase a license for Jet, please contact Burk Technology at
978-486-0086, or via email at sales@burk.com.
Virtual Channel List
The Virtual Channel List displays the name and live value of each Virtual Channel. From this list you can
add, edit, delete, and rename Virtual Channels.
The Virtual Channel List, by default, is docked to the right side of the screen and set to auto hide.

Virtual Channel List
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Creating a New Virtual Channel
To create a new Virtual Channel, click the New toolbar button on the Virtual Channel List.
A Virtual Channel is defined using real channels, constant values, operators and functions. You can type
a Virtual Channel definition directly into the editor if you are already familiar with the syntax.
Otherwise, use the operator buttons and function list to build your channel.
For a complete description of Virtual Channel syntax, please see the Virtual Channel Syntax Reference
(PAGE 111).
Virtual Channels are interpreted as either Meter or Status channels. Use the option buttons for Meter
and Status on the Virtual Channel Editor to select the appropriate channel type. Meter channels are
reported as a numeric value. Status channels are reported as a Boolean (true/false) value.
Note: To see the value of your Virtual Channel while you are editing it, click the Test button.
When you have completed your Virtual Channel definition, click the Save button. The Virtual Channel
Editor will prompt you to name your new channel.

Virtual Channel Editor

Editing a Virtual Channel
To edit an existing Virtual Channel, select it in the Virtual Channel List and click the Edit button on the
toolbar. AutoPilot will open the channel in the Virtual Channel Editor, allowing you to make changes to
its definition.
Renaming a Virtual Channel
To rename an existing Virtual Channel, right-click on the channel in the Virtual Channel List and select
Rename from the context menu. Each Virtual Channel must have a unique name.
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Deleting a Virtual Channel
To delete a Virtual Channel, right-click on the channel in the Virtual Channel List and select Delete from
the context menu.
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Reference
Custom Views
Controls
Command Buttons
Command Button (See also Password Command Button, below)
A standard command button.

LED Button
A command button with an embedded LED.

LED Button (2 Lines Centered)
A commands button with an embedded LED and a 2 line centered caption label.

LED Button (2 Lines)
A commands button with an embedded LED and a 2 line caption label.

Password Command Button
This command button requires a password for activation. A password must be entered for this control
using the Custom View Editor. When the Password Command Button is clicked in a Custom View, a
password confirmation dialog box is displayed requiring entry of the correct password before the
corresponding action is taken.
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Sticky Button
The Sticky Button remains "stuck" down when its status condition is "ON". This control works best when
used in mutually exclusive pairs.

General
Camera Picture (See also Video, below)
Embeds a web cam picture in your Custom View.

Clock
A simple clock with adjustable time zone offset and flexible display format.

The Format property can be used to define how the date and/or time will be displayed by the Clock
object. The default format, shown in the image above, is displayed if the Format property is left blank.
This format could also be specified by entering the following text string for the Format property: “h/m/s
tt” where “h” specifies the current hour shown as 1 through 12, “m” specifies the current minute shown
as 0 through 59, “s” specifies the current second shown as 0 through 59, and “tt” specifies the display of
AM or PM.
A different display format can be specified by combining elements from the table below into a text
string defining the desired representation of date and/or time and entering that string for the Format
property.
Format Specifier
"d"
"dd"
"ddd"
"dddd"
"h"
"hh"
"H"

Description
The day of the month, from 1 through 31.
The day of the month, from 01 through 31.
The abbreviated name of the day of the week.
The full name of the day of the week.
The hour, using a 12-hour clock from 1 to 12.
The hour, using a 12-hour clock from 01 to 12.
The hour, using a 24-hour clock from 0 to 23.
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Format Specifier
"HH"
"m"
"mm"
"M"
"MM"
"MMM"
"MMMM"
"s"
"ss"
"t"
"tt"
"y"
"yy"
"yyyy"
":"
"/"

Description
The hour, using a 24-hour clock from 00 to 23.
The minute, from 0 through 59.
The minute, from 00 through 59.
The month, from 1 through 12.
The month, from 01 through 12.
The abbreviated name of the month.
The full name of the month.
The second, from 0 through 59.
The second, from 00 through 59.
The first character of the AM/PM designator.
The AM/PM designator.
The year, from 0 to 99.
The year, from 00 to 99.
The year as a four-digit number.
The time separator.
The date separator.

Custom View Extents
Set the aspect ratio for auto scaling of custom views.

Label
A basic, general purpose label control.

Line
Draws a straight line.
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Map
A resizable map. State maps are available, as well as a map of the US.

Picture
Embeds an image in your custom view. The image is saved with your Custom View, and will work even
if the view is loaded on another computer.
Text File
Shows the contents of any text file on your computer.

Video
The Video object displays the video stream from a webcam using the RTSP protocol.

The Connection properties for this custom view element are as follows:
Complete URL
Host
Password
Path
Port
Query
Scheme

Complete URL to camera image path
The IP address or URL of the camera
The password assigned to the camera
This can be left blank unless required by the camera
The RTSP port number used by the camera. Setting to -1 applies the default value
of 554.
This can be left blank unless required by the camera
Must be set to RTSP
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Username

The username assigned to the camera

Weather Map
A weather map from the National Weather Service. Can be displayed as a static image or animation.

Web Page
The Web Page control allows you to embed a web page directly in your Custom View.

Web Picture
Embeds any image from a web site. Can be set to periodically refresh.
Meters
Angular Meter
A classic gauge.

95

Angular Meter (Advanced)
A classic gauge with additional Labels and Meter properties.

Bar Meter
Displays a meter on a linear meter that fills in with color to indicate value.

Chart
A strip chart control that supports multiple lines. See Using Charts (PAGE 33) for more information.

Compass
Use the compass control to display direction.
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Linear Meter
Displays a meter value on a linear indicator. Can be oriented horizontally or vertically.

Nominal Bar
The nominal bar displays a meter value relative to a specified nominal value. This allows an operator to
quickly determine what parameters are out of tolerance.

Power Meter
Displays power using both W (or kW) and dBm.

Right Angle Meter
A gauge-style meter starting on the left and spanning 90°.

Text Meter
A simple non-graphical meter display.
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Thermometer
Displays temperature values.

Trend Arrow
Indicates whether a meter channel is trending up or down, or is steady.

VSWR Meter
The VSWR meter automatically calculates VSWR using forward and reflected power.

Network Management
Network Device
Represents a network device. The color of the icon indicates the state of the device. Icons are available
for a wide range of standard equipment.

Network Device Label
Displays the name of a Network Device. The background color represents the status of the device.

SNMP String
Displays the text received from a text parameter on an SNMP agent.

98

SNMP Up Time
Displays up time data received from an SNMP agent, formatted as a duration.

Shapes
Rectangle
A rectangle or square.

Oval
An oval or circle.

Specialized
Summary Site Status and Summary Group Status Controls
The Summary Site Status and Summary Group Status controls make it possible to display a summary of
alarm conditions for a single site, or for a group of sites, in a single graphical element. These graphical
elements use a color grid of consisting of one to four colors, depending on the type of alarms associated
with the group. The four color categories are as follows:
•
•
•
•

Green – No critical or warning alarms
Yellow – Warning alarms
Red – Critical alarms
Grey – Site is not communicating with AutoPilot
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Sites
The Summay Site Status control shows the name of the site and a color bar that represents one of five
states, as described in the following table. If the site has critical or warning alarms, the total number of
alarms is shown in the red or yellow box.
Green – Site is connected with no
critical alarms or warnings.

Grey— Site is not communicating
with AutoPilot.

Yellow – Site has warning alarms.

Red – Site has critical alarms.

Split red/yellow – Site has critical
alarms and warnings. In this
example, the site has 7 critical
alarm and 2 warnings.

Groups
The Summary Group Status control shows the group name on the top line. Below the text, a color bar
represents the group states along with the number of sites in a group (in cases where a single number
appears). For alarms, (yellow and red), the number of alarms appears, followed by the number of sites
that are reporting the alarms.
To get detailed information on a group, click its control.
Green – All sites are
communicating, with no alarms
or warnings.
Grey— None of the sites in the
group are communicating with
AutoPilot.
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Yellow – At least one site in the
group has one or more warning
alarms. In this example, three
alarms are occurring at one site.
Red – At least one site in the
group has one or more critical
alarms. In this example, a total of
four critical alarms are occurring
at two sites.
Red/Yellow – At least one site in
the group has one or more critical
alarms and at least one site has
one or more warning alarms. In
this example, one site is reporting
a critical alarm and three warning
alarms are occurring among two
sites.

When some of the sites in the group are not communicating with Autopilot, the right-most (grey)
column displays the number of sites that are not communicating. The two-left columns display green,
red and yellow columns, as described in the previous table.

In this example, the following conditions exist:
•
•
•

Three sites (grey) are not communicating with Autopilot
One site (red) is reporting a critical error.
Three warning errors are occurring between two sites (yellow).

To add a Summary Site Status or Summary Group Status control, drag one of the following items from
the Specialized list in the Custom View Editor.
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In the Properties panel, click on the three-dot icon next to Channel Adaptor .

Select a Channel Adaptor to link the control to a Site or a Group.
To link to a Site, select the Network that contains the Site and the Site you want to link to this control.

To link to a Group, select a Node from the list.

If you check “Automatically set related properties”, the site or group name will automatically populate
based on the selected item. In the Properties panel, you can specify additional settings that define the
appearance of the Summary Site Status or Summary Group Status control (such as color mapping for
alarm levels, caption text, etc.) or you can accept the default settings.
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Status
Arrow LED
Displays an arrow pointing up, down, left, or right.

Diamond LED
A diamond-shaped LED.

Label LED
A rectangular LED that includes a caption. The caption changes based on the status condition.

Label LED (2 Lines Centered)
A rectangular LED that includes a 2 line caption centered on the object. The caption changes based on
the status condition.

Label LED (2 Lines)
A rectangular LED that includes a 2 line caption. The caption changes based on the status condition.

Rectangular LED
A rectangular LED.

Round LED
A round LED.

103

Status Label
The status label control displays different labels for "ON" and "OFF".

Status Line
A line that changes color based on the status condition.

Status Panel
The status panel is used to provide a background that changes color based on status for part or all of
your Custom View.
Status Picture
The status picture shows one picture when "ON" and another picture when "OFF".
Status Sound
The status sound plays a sound file based on a status condition, as long as the Custom View hosting the
control is on screen.
The status sound control does not appear on your Custom View, except in the Custom View Editor.
Timers
Timer Channel
Displays the value of one of the 64 available timer channels.
(Available only on the ARC Plus Touch firmware version 5.0.14.1 or greater)
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Status Conditions
Available status conditions for the Channel Adapter property of status custom view objects.
Status Channel
Raise Relay Active
Lower Relay Active
Macro Running
Meter Below Low Critical
Meter Below Low Warning
Meter Above High Warning
Meter Above High Critical
Meter Out of Tolerance
Site in Alarm
Network in Alarm
Site Connected
Site in Maintenance Mode
Active Flowchart Running
Virtual Channel
Any Network in Alarm
Site Connected On Primary
Site Connected On Backup

A status channel on a remote control unit.
"ON" when the specified raise relay is engaged.
"ON" when the specified lower relay is engaged.
"ON" when the specified macro is running.
"ON" when the specified meter is below the second lower limit.
"ON" when the specified meter is below the first lower limit.
"ON" when the specified meter is above the first upper limit.
"ON" when the specified meter is above the second upper limit.
"ON" when a meter is outside of its "normal" range (above either
upper limit or below either lower limit).
"ON" when the specified site has at least on uncleared alarm.
"ON" when any site in the specified network has at least one
uncleared alarm.
"ON" when the specified site is connected to AutoPilot.
"ON" when the specified site is in maintenance mode
“ON” when the specified Jet Active Flowchart is running.
“ON” when the specified virtual channel evaluates to true.
“ON” when any connected site on any network has an alarm
condition.
“ON” when the specified site is connected over the primary
connection.
“ON” when the specified site is connected over the backup
connection.
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Actions
Available actions for custom view objects with a command adapter property.
Raise
Lower
Navigate
Run Macro
Stop Macro
Clear Alarms
Connect
Disconnect
Run Application
Open URL
Print Report
Ping
Navigate (New Window)
Show Default View
Show Default View (New
Window)
Run Active Flowchart
Stop Active Flowchart

Issues the specified raise command.
Issues the specified lower command.
Opens the specified Custom View in the current window.
Starts the specified macro.
Stops the specified macro.
Clears alarms on the specified site or network.
Connects to the specified site using the primary connection.
Disconnects from the specified site.
Runs the specified command in Windows to launch an
application.
Opens a web browser with the specified URL.
Prints the specified report using the default printer.
Pings the specified Network Device.
Opens the specified Custom View in a new window.
Opens the Default View for the specified site in the current
window.
Opens the Default View for the specified site in a new window.
Runs the specified Jet Active Flowchart.
Stops the specified Jet Active Flowchart.

Database Schema
Note: The onboard database and SQLite Server database use the same schema.
Directly accessing the onboard database is not recommended.
Tables
The following tables are included in the database:
Table Name
Alarms
Events
StatusChanges
Telemetry

Description
Stores alarms.
Stores events.
Stores a record for each time a status channel changed.
Stores a snapshot of meter and status channels for each time AutoPilot takes a
log.
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Alarms
Field
UTCDateTime
NetworkName
UnitName
UnitID
AlarmTypeID

Data Type
Date/Time
String
String
Integer
Integer

AlarmSeverityID Integer

ChannelNumber

Integer

ChannelName

String

AlarmMessage
TimeZoneOffset
AlarmClass

String
Integer
Integer

SourceIndex

Integer

UTCInactiveTime Date/Time
Disposition

Priority

Integer

Byte

Description
The date and time of the alarm using UTC time.
The name of the network on which the alarm occurred.
The name of the site on which the alarm occurred.
The unique ID identifying the remote control unit.
Indicates what type of alarm this is:
0
High Limit
1
Low Limit
2
Status
3
System
4
User
Indicates the severity of the alarm:
-1 Normal
0
Warning
1
Critical
The channel number on which this alarm occurred. This value is
0 for non-channelized alarms.
The label of the channel on which this alarm occurred. This value
is blank for non-channelized alarms.
The message associated with the alarm.
The time zone offset (number of minutes from UTC) for this site.
Describes the type of source for the alarm. Used internally by
AutoPilot.
Used along with the Alarm Class to uniquely identify the alarm.
Used internally by AutoPilot.
The time (UTC) when the alarm became inactive. Not applicable
for incidental alarms or active alarms.
The current disposition of the alarm:
0
Incidental
1
Active
2
Inactive
The user-defined priority of this alarm. A value of 0 is used when
no priority is set.
Note: A value of 1 may be either the highest or lowest priority.
Within AutoPilot, this value is only used for sorting purposes and
does not otherwise impact functionality.
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Events
Field
UTCDateTime
NetworkName
UnitName
UnitID
EventTypeID

Data Type
Date/Time
String
String
Integer
Integer

Description
The date and time of the event using UTC time.
The name of the network on which the event occurred.
The name of the site on which the event occurred.
The unique ID identifying the remote control unit.
Describes the type of event. Used internally by AutoPilot.
Note: The values available for this field are numerous and subject
to change.

EventMessage
TimeZoneOffset
Status Changes
Field
UTCDateTime
NetworkName
UnitName
UnitID
ChannelNumber
StatusValue
StatusMessage
StatusStateID

TimeZoneOffset

String
Integer

Data Type
Date/Time
String
String
Integer
Integer
Boolean
String
Integer

Integer

Using this field is not recommended.
Describes the event.
The time zone offset (number of minutes from UTC) for this site.

Description
The date and time of the status change using UTC time.
The name of the network on which the status change occurred.
The name of the site on which the status change occurred.
The unique ID identifying the remote control unit.
The channel number whose status changed.
The value of the status channel after the change.
The status label associated with the new value.
The alarm state of the status channel:
-1
Normal
0
Warning
1
Critical
The time zone offset (number of minutes from UTC) for this site.
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Telemetry
Field
UTCDateTime
NetworkName
UnitName
UnitID
ChannelNumber
ChannelName
MeterValue
Units
AnalogStateID

StatusValue
StatusMessage
StatusStateID

TimeZoneOffset

Data Type
Date/Time
String
String
Integer
Integer
String
Single
String
Integer

Description
The date and time of the snapshot using UTC time.
The name of the network on which the snapshot occurred.
The name of the site on which the snapshot occurred.
The unique ID identifying the remote control unit.
The channel number included in this snapshot.
The meter label for this channel.
The calibrated value of the meter channel.
The units label for the meter channel.
The alarm state of this meter channel:

Boolean
String
Integer

-1 Normal
0 Warning
1 Critical
The value of the status channel.
The status label associated with the status value.
The alarm state of the status channel:

Integer

-1 Normal
0 Warning
1 Critical
The time zone offset (number of minutes from UTC) for this site.
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Jet Actions and Conditions
Actions
Alarm
Clear Alarms
Close Custom
View
Decrement
Email Report
Increment
Log Message
Lower
Message
Open Custom
View
Raise
Reset Timer
Send Email
Set
Set Flowchart
Set Limit
Set Macro
Set Memory
Set Mute
Speak Phrase
Start Timer
Stop Timer
Take Capture
Take Log
Wait

(ARC Plus and ARC Solo) Creates a new alarm on the ARC Plus or ARC Solo.
(AutoPilot only) Clears all alarms on the selected ARC Plus or ARC Solo.
(AutoPilot only) Closes the selected custom view on the AutoPilot computer.
Subtracts 1 from the specified memory variable.
(ARC Plus and ARC Solo) Emails a report using a template.
Adds 1 to the specified memory variable.
(AutoPilot only) Adds the specified message to the Event Log on the selected
ARC Plus or ARC Solo.
Issues a Lower command for the specified channel.
(ARC Plus and ARC Solo) Adds the specified message to the unit’s Event Log.
(AutoPilot only) Opens the selected custom view on the AutoPilot computer.
Issues a Raise command for the specified channel.
(ARC Plus firmware 5.0.14.1 or greater) Resets one of the 64 independent
timers on the selected site.
Sends an email message.
(ARC Plus only) Sets a meter channel value, a status channel value or a
memory value.
(AutoPilot only) Starts or stops a flowchart.
(ARC Plus and ARC Solo) Sets a meter limit to the specified value.
Starts or stops a macro.
Sets a memory variable to the specified value.
(ARC Plus and ARC Solo) Mutes or unmutes a channel.
(ARC Plus and ARC Solo) Causes the ESI/RSI to speak the specified phrase
when configured for audio output.
(ARC Plus firmware 5.0.14.1 or greater) Starts one of the 64 independent
timers on the selected site.
(ARC Plus firmware 5.0.14.1 or greater) Stops one of the 64 independent timers
on the selected site.
(ARC Plus only) Captures channel values locally on the ARC Plus.
(AutoPilot only) Logs the specified site.
Pauses the flowchart for the specified duration.
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Conditions
If
If Alarm
If Calendar Time
If Date
If Day
If Day of Month
If Flowchart
If Macro
If Maint mode
If Memory
If Month
If New Status
If New Value
If Relay State
If Status
If Time
If Value

Evaluates a meter, status or memory variable to a specified constant.
Evaluates the number of alarms on the specified site.
Determines if the current time matches the specified calendar time.
Determines if the current date matches the specified date.
Determines if the current weekday matches the specified weekday.
Determines if the current day the month matches the specified day.
(AutoPilot only) Evaluates the state of the specified flowchart.
Evaluates the state of the specified macro.
Determines if a site is in maintenance mode.
Evaluates the specified memory variable.
Determines if the current month matches the specified month.
Evaluates a status channel after waiting for a new reading.
Evaluates a meter channel after waiting for a new reading.
Evaluates the relay state of the specified channel.
Evaluates the specified status channel.
Determines if the current time matches the specified time.
Evaluates the specified meter channel.

Virtual Channel Syntax
Operators and Constants
+
Addition
Subtraction
*
Multiplication
/
Division
Mod
Modulo
Pi
The constant Pi (π)
E
The constant e
=
Equals
<
Less than
>
Greater than
<=
Less than or equal
>=
Greater than or equal
<>
Not equal
(
Open paren
)
Close paren
And
Logical and
Or
Logical or
Not
Logical not
Xor
Logical exclusive or
True
The constant true
False
The constant false
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Functions
Site Functions
Meter
Status
RelayRaised
RelayLowered
InAlarm
MaintMode

Jet
MemoryVariable
VirtualMeter
VirtualStatus

Returns the value of a meter channel.
Returns the value of a status channel.
Returns true if the command channel is raised.
Returns true if the command channel is lowered.
Returns true if the site is in alarm.
Returns true if the site is in maintenance (local) mode.

Returns the value of a flowhcart memory variable.
Returns the value of a virtual meter channel.
Returns the value of a virtual status channel.

Math and Logic Functions
Abs
Absolute value
Acos
Arccosine
Asin
Arcsine
Atan
Arctangent
Atan2
Arctangent (angle from the x-axis to the specified point
Ceiling
Returns the smallest integer greater than or equal to the specified number.
Cos
Cosine
Exp
Returns the constant e raised to a power.
Floor
Returns the greatest integer less than or equal to the specified number.
Iff
Evaluates a condition and returns one value if true and the other if false.
Log
Returns the log of a number using the specified base.
Log10
Log base 10
Max
Returns the largest value from a list.
Min
Returns the smallest value from a list.
Ln
Natural log
Pow
Returns the value of a number raised to a specified power.
Round
Returns a number rounded to the nearest integer.
Sin
Sine
Sqrt
Square root
Tan
Tangent
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Date/Time Functions
Now
Weekday
Today
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

Calendar Functions
PreSunrise
Sunrise
Sunset
PostSunset
User1
User2

The current date and time.
The current weekday.
The current date.
The constant value for Sunday.
The constant value for Monday.
The constant value for Tuesday.
The constant value for Wednesday.
The constant value for Thursday.
The constant value for Friday.
The constant value for Saturday.

Returns the date/time for Pre-Sunrise for the current month.
Returns the date/time for Sunrise for the current month.
Returns the date/time for Sunset for the current month.
Returns the date/time for Post-Sunset for the current month.
Returns the date/time for User 1 for the current month.
Returns the date/time for User 2 for the current month.
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